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1. Introduction

This is the command reference for the NIPO ODIN scripting language.

Please make sure to always use the latest ODIN Developer version. It can be downloaded from our
support website. Ask the NIPO support team to allow you to download the latest version of ODIN
(currently, the latest version is 5.18.021).

In this reference we are only showing the features of ODIN Developer relevant to Nfield, even though
ODIN Developer also supports commands for NFS.

Please also note that all examples in this reference are based on the default NIPO template (Nfield
Chicago). If you use a different template, the *UIOPTIONS and the *UIRENDER might be different for
your template than in the examples shown.

1.1 Terminology

This section provides a brief overview of the terminology used within this document.

1.1.1 General

Question type

Defines the type of answer which is expected for a question. Question types are for example closed,
open, numerical, etc.

Question option

Defines what special properties an answer must have or how answer categories will be displayed.
There are question options to allow multiple answers, set a maximum value to be entered, show
answer categories in random order, etc.

Answer option

Defines the behavior of the program when an answer category is chosen. There are answer options to
prevent that an answer is combined with other answer categories, to prompt for an open answer, etc.

1.1.2 Questions and Answers

Closed question

A question where the answer is expected to be a choice from a fixed number of answer categories.

Answer code category

One of the possible answers defined for a (semi-)closed question.
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Open question

A question where the answer is expected to be entered literally as text.

Semi-closed question

A question where the answer is expected to be a choice from a fixed number of answer categories
and where certain answer categories have a box to enter an alternative answers as text.

Open-ended answer

The literal text of an answer entered for an open or semi-closed or open question.

Numerical question

A question where an answer is expected to be a numerical value.
Text question

A question where an answer is expected to be text of limited length.
Answer code

A numeric value which is stored in the DAT-file when an answer category is chosen.
Answer field

A (series of) positions in the DAT-file where answer codes, values or texts are stored.

1.1.3 Files and Tables

Q-file (questionnaire)

Unicode file containing the question text and all the NIPO ODIN commands for routing, et cetera.
Sample table

Table in the database containing the gross sample. Each record in the sample table contains
information (telephone number, address, name, company size, etc.) about one (future) respondent.
DAT-file

Unicode text file containing answer codes that refer to chosen answer categories of closed questions,
values entered for numerical questions and texts entered for text questions.

O-file

Unicode text file containing all open answers entered by keyboard.
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2. Using the NIPO ODIN Developer

The NIPO ODIN Developer is the NIPO ODIN script author's tool. It can be used for the following
purposes:

e C(Create, edit and syntax-check questionnaires for Nfield.

e Run a preview of the questionnaire.

e Generate dummy (test) data to verify questionnaire integrity.

e  Export survey data for statistical analysis in various packages.

This section briefly discusses a number of features of the NIPO ODIN Developer.

21  The Script Editor Window

211 Line Size

A line in the NIPO ODIN Developer may be up to 4000 characters long. Scrolling in a very long line
might be slow - use Edit > Goto position to easily place the cursor on a certain position. To open data
files, select File > Open data file... from the menu.

2.1.2 Pop-up Menu Options

For any open file in the script editor window, right-click anywhere to open the pop-up menu. This
section describes a number of those options.

2121  Inserting Question Definitions

To simplify creating NIPO ODIN Questionnaire, right-click the editor window and select Insert to
choose from the available question options.



Inserting a question
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@ NIPO ODIN Developer 5.18 - [Untitled1]
DEE &7 iIHHEEE| bR E

(@ Eile Edit View QDIN Settings Window Help

B | M S5 IE BT Ba

Question Preview  »
[ Insert [ Closed question
Open document Numerical question
Undo Open question
Redo Form question
= Text question
- Seale question
i Line question
Grid question
(1 SelectAll
Question
@ Find..
Clear All Marks
< >
@® Untiled1
x
s
TA;
Bl 1418 1 Results
Insert closed question Ln1/1, Col 1 MUM SCRL

2122  Changing Question Options

Right-click on a question line to change the question options. Depending on the type of question,

one of the following dialog boxes appears.

Changing the general question options

Cuestion Properties

General  Closed

Display
[ allow no answer
[Joon't dear screen

[ bisplay picture
MName: Type: |5Siring

Library name:

CFiter

Storage
Position: | | Field: | 1
use sample file

[Jsave answer in variable:

Diana variables

[ attach label
[ variable
Concet | [N
° ° ° . . . . . ° ° °



Changing the question options for a *CODES question

Cuestion Properties

General Closed

[ Multiple answers
[ auto format
[l contral by question Incude Mark
[ code list Type: | String
Onin
max

Answer order

(® MNormal

(T Random

() Inverted

(O Rotated

Cancel Aoply

The options you see depend on the question types.

2.2  Syntax Checking

Using the NIPO ODIN Developer

You can syntax check your questionnaire by selecting ODIN > Check... from the menu. A dialog

appears in which warning options may be configured. Warnings are issues that may lead to unwanted

behavior and / or loss of data, but do not prevent the questionnaire from running.

Note: By clicking on individual error or warning messages, the line in the code to which that error or

warning pertains becomes highlighted and comes into focus.
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NIPO ODIN Developer check options

NIPO ODIN Developer Options x

= ODIN G Check

F@h Interview Syste
@ Coding System
5 (®) Don't suppress wamings

... Dummy Data () Suppress all waminas

= Editor (O Suppress: — Wamings

: @ Print Too many positions for question
@ Autosave Multiple use of position

Suppress Wamings

@ Files Jump to previous question
Code questions without codes

Missing quotes

Mayimum data position 200000

Fitter duplicate emor messages
[ Keep previous resutts
[ Keep results after closing file

Cancel Aonly Help

You may select the following options:

Don't suppress warnings. All warnings are reported.
Suppress all warnings. None of the warnings are reported.
Suppress. You can select which warnings to suppress.

The following warnings may optionally be suppressed:

Too many positions for question. Applies if more positions are defined than strictly required to
store the input data. The length definition of a *CODES question reserves more space than
required to store the answer codes. This may sometimes be the case for any question where
*MULTI was accidentally omitted.

MAX positions for Diana. Applies if more than 200,000 positions are used.

Multiple use of position. Applies if a particular position is accessed to store information from
more than one question. This may cause the data to be overwritten. This warning is ignored for
positions in a *DUMMY question.

Jump to previous question. Applies if a *GOTO is used to jump back instead of forward in the
questionnaire, which may cause an infinite loop. It is recommended to use *BACK instead.
Code question without codes. Code questions without codes are skipped, therefore a warning
can be issued if a code question misses codes. This warning is ignored for *CODES questions in
combination with *DuMMY.

Missing quotes. Applies to quoted text where a closing quote is missing.

Maximum data positions

Sets the maximum amount of positions allowed for a single interview. This is useful to match NIPO

ODIN to the limit of your data processing system. Nfield limit is 200,000 positions.
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Filter duplicate error messages

This limits the number of reports per error message. For example, duplicate use of a position in the
DAT-file may only need to be reported once.

Keep previous results

Results of a previous syntax check are not cleared for a new syntax check; instead, a new window is
opened so that results may be compared.

Keep results after closing file

Keeps the Results window open once the questionnaire file is closed in the editor.
2.21 Warning Message for *CODES Question Without Code Categories

If no code categories are defined for a *CODES question a warning is displayed upon a syntax check.

No warning is supplied if a question text is also missing.
2.2.2 Warning Message for Unfixed Questions

You can test-run a questionnaire within the NIPO ODIN Developer NIPO ODIN Developer with unfixed
questions, but can not run the questionnaire in Nfield with unfixed questions.

The NIPO ODIN Developer gives a warning message upon syntax check if any unfixed questions
(length definitions without position definition) have been defined in the NIPO ODIN Questionnaire.
Only one warning is ever generated for the first line where an unfixed question was found.

Select ODIN > Fix or click the Fix button to fix the questions.

223 Error on *FORM Question Language Section Mismatch

The syntax check reports an error message when a *FORM question in the language section does not
contain any fields (*NUMBER or *ALPHA). The syntax check also reports an error message when a field
(*NUMBER or *ALPHA) is specified in a question that is not defined as *FORM.

2.2.4 Undeclared Variables are Created when Fixing a Questionnaire

If a variable is not declared before it is being used, a warning message appears. When fixing the data
positions or renumbering a questionnaire, these variable name declarations are automatically added
to the questionnaire as *TEXTVARS variables. Make sure no mistakes are made in the variable name,
and verify if *TEXTVARS is an appropriate type.
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2.2.5 Results Window Keeps Previous Syntax Checks

The Results window of a syntax check keeps previous syntax checks. Right-click the window and
select Remove tab to close the result window. Click on the cross on the upper-left corner or use the
View > Results from the menu to toggle showing the docking window.

2.3 Test Run Questionnaire

Save your questionnaire and select ODIN > Run from the menu and select to preview the

. . . . . +3 . . S
questionnaire in NIPO CATI (or just click on the Runicon — , which automatically starts a preview in
CATI). You could also do a preview in Nfield. For that, please refer to our NIPO ODIN Scripter Basic

course.
2.31 Question Highlight in NIPO CATI Preview

For a NIPO CATI preview, the NIPO ODIN Developer highlights the question currently in focus in the
script window. This helps in reviewing the question in focus during a preview run.

Note:
Special characters in the file path (underscores, ampersands et cetera) are not supported.

(©) NIPO ODIN Developer 5.18 - [1q] — [m] X
= & 7 ! B
- &8 x

File Edit View ODIN Settings Window Help

T Male
2 Fenale

%IF [Q1.1] xPUT Gender 'Male” ; . _
*IF [01.2] *PUT Gender “Femals® @ NPO Interview System: 1

*STRAT 993 Actions View Help

*QUESTION 2
Ve are conducting a study about cars Clear
Our study will take a maximum of 10 minute
#* Duestionnaire
*QUESTION 998 Are you male or female?
Thank vou for your participation, emjoy yg 1:Male

*END 2:Female

*QUESTION 999

I am sorry you do not fall into the group
Ve thank vou for your participation
*ENDST 21

#0100 *FORM

v

x|Starting parse of C:“Scripts~lg ..
H|Parse finished
Starting CATI environment check. ..
C:“Scriptshlg (Line 15): Info: End of ques
C:“Scriptshlg (Line 15): Info: Sub survey
C:“Scriptshlg (Line 15): Info: 61 —
C:“Scriptshlg (Line 15): Info: 102 -
C . ~Scriptshlg (Line 15} Info: Overview of v

Resulls

' Check - 14:56:31
Ln 2/22, Col1 NUM SCRL READONLY

For Help, press F1

Question highlight

The script cannot be edited during the preview. When exiting the preview run, the cursor remains at

the last highlighted question.
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This feature requires that the NIPO CATI Client used for preview is version 5.11 or newer. If the
highlight does not work, verify that the correct NIPO CATI Client version is in use (see "Interview
System Options" on page 36). In addition, enable Adjustable screen size to see the script window.

Note:
This feature is only available for a NIPO CATI preview.

2.3.2 Check Routing for Stratification

When using the command *STRAT in a questionnaire, for each occurrence a message dialog
‘stratification filled? Yes/No’ pops up. Select the appropriate answer to test your routing. Note that
no telephone file or sample table is used.

2.3.3 Show Variables

For NIPO CATI preview, you can show the contents of the currently known variables by selecting View
> View variables... from the menu. Note that system variables that appear are also NFS system
variables, and not only the Nfield ones. Other variables have to be declared with *VARS, *TEXTVARS
or *SAMPLEDATA first.

2.4  Menu Options

2.4.1 Open Data Files

The regular script editor is capable of managing up to 4,000 horizontal positions. To open larger
(data) files, select File > Open Data File... from the menu. This opens files up to 99,999 horizontal
positions, and cancels syntax highlighting.

2.4.2 Remove Commands

To be able to create a client-friendly questionnaire as well as to translate your questionnaire, select
ODIN > Remove Commands... from the menu. This option creates a translatable *LANGUAGE section
without NIPO ODIN commands, except for *QUESTION, *FONT and *?varname, that may be linked to
the original questionnaire using the *LANGUAGE command.

2.4.3 Comment / Uncomment

Select a block or a couple of lines and select Edit > Comment to make comments of these line. This
inserts a ** in front of all selected lines. Select Edit > Uncomment to remove the ** from the

selected lines.
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2.4.4 Create Questionnaires in Unicode

This means full support for all non-western languages, like Hebrew, Arabic, Chinese, Japanese, et
cetera. Unicode is enforced by saving the file as type UTF-16. This is required for all extended
characters in questionnaires for Nfield.

2.4.5 Find Function with Regular Expressions and Mark All
Select Edit > Find to search for specific text in your questionnaire. Click Mark All to mark entries

found in the side bar.
Find function

Find *
Find what: [B v| [ FindNext
[ Match whale word only Direction Mark All

[ tdatch case Oup

[ Regular expression ® Down Caes

2.4.6 Start Editor in Workbook Mode

Select View > Workbook to enable or disable showing windows in a workbook mode. The workbook
mode makes switching windows easier.

2.4.7 Create Code Numbers Before Code Labels and Fields

Select the lines you want to number, then select the ODIN > Insert numbers from the menu.

The NIPO ODIN Developer does not immediately verify code numbers against any duplicates or
against the question definition. To create unique numbers, do not update partial lists. Use the syntax
check to check on duplicate code numbers. Numbering is performed on all lines containing a carriage
return.
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©

D &5 &% iwpwieln BE =
%@Eile Edit View ODIN Settings Window Help - a8 X

<
.D|_:|

1[M DevelopersT empl: mplatel elatedF

I|M DevelopersTemplates' T emplateRelatedFiles

| *#*JTESTION 2 *=CODES 74L10 =MULTI
Which are vour fawvorite sports.
B Foothsll (Soooer
Insert nurmbers x
| Badninton
Volleyball Start: | 1
I 1 Increment: | 1 |
[] align codes
| Keep old numbers
[Jsort
l Ascending
Descending
|
ML Cancel

) Untitled?

=
L3
|
[
Z ﬁ'\lﬂesuhff’
{For Help, press F1 Ln 4/14, Col

Creating code category numbers
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@' MIPO ODIN Developer 5.18 - [Untitled2]
D= ST WMy | BB
@Eile Edit View ODIN Settings Window Help

F-% FEE FEE N
S | M %ss 0 &% aa

|l DevelopersT emplates’T emplateR elatedFile R | ':_['-

#*JUESTION 2 =CODES 74110 =MULTI
Which are vour favorite sports.

1:Football {Soccer)
2:(Field) Hoclkey
3. Tenni=

4:Badminton
5 Volleyball
6 Bazketball
7 Ba=sball
8 :Squash
9 Others
0

10:I hate sports

44 ¢ M\ Results

| Results

For Help, press F1

Ln 14714, Col

Result

2.5 The NIPO ODIN Developer

The NIPO ODIN Developer allows you to export your data to a variety of statistical software packages.

The following formats are supported:
e NIPO Diana / Nvision Script

e Triple-S XML

e SPSS Portable
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e SPSS-PC (script format)
e Ascribe
e Quantime

e Image / Sound

2.5.1 NIPO Diana/DSC Export

The export to NIPO Diana/DSC may be used to create files that may be used by both NIPO Diana and
Nvision Script, as well as input for the NIPO DSC. This export is also known as .Var export.

Export to NIPO Diana/DSC variables

DIAMA x
S
Language: Defauft language o |
Cancel
[ ] Add fitters to variables
[ ] Variable name in front of question text [ ]+ILF Save
[ ]Use CODE 'n'ff no code text specified
[ ] 'Question n:"in front of question text []+[LF]

[ ]Write randem and order numbers

[ ]Insert [LF]in question text

[ ]Insert [LF]in code text

[ ] Include questions without text and unused guestions

[ ]Generate codes for scale questions

[ ] Include null-evaluating fitter and dummy questions

[ ] No duplicate text for “OPEN’ and “NUMEER' questions
] No commert lines in var file

[] Matrix text as DSC table label

Maximum codes per varable:
Line length:

[ ]0pen VAR file after export
[ ] Unicode VAR fil=

Choose the following options:

Language
If more than one language is defined within the questionnaire, select the language to use for the
question and code labels in the export.

Add filters to variables
Any questionnaire filters are also defined in the variables.
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Variable name in front of question text
The question label is preceded by the export name of the variable. Optionally add a line feed to the

variable name.

Use CODE ‘n‘ if no code text specified
For code category labels without text, a label is created containing the word 'CODE' followed by the

code number.

‘Question n’ in front of question text
All question texts are preceded by the word "Question" followed by the question number originally
used in the questionnaire. Optionally add a line feed to the variable name.

Write random and order numbers

This option is not relevant for Nfield.

Insert [LF] in question text
If line feeds are used in the question labels, these are transferred in the export. Duplicate line feeds
are removed. By default, line feeds are translated into spaces.

Insert [LF] in code text
If line feeds are used in the code labels, these are transferred in the export. Duplicate line feeds are
removed. By default, line feeds are translated into spaces.

Include questions without text and unused questions
Exports questions without text and questions that are never shown due to routing. By default, these
are not exported.

Include null-evaluating filter and dummy questions
Exports questions that use a filter that always evaluates to false (for example *IF [ 1 = 0])and
*DUMMY questions. By default, these are not exported.

No duplicate text for *OPEN and *NUMBER questions
For *OPEN and *NUMBER questions, creates a label with the question text, removing the label for the

question text.

No comment lines in VAR file

Removes comment lines (com) from the variable file. Comment lines are used as export directives for
the NIPO DSC for IBM SPSS, but NIPO Diana cannot correctly handle certain comment directives.
Check this option if the export must be used by NIPO Diana. Do not check this option if the export
must be used by the NIPO DSC for IBM SPSS.
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Maximum codes per variable
Enforces a maximum number of codes per variable. Codes beyond this limit are not exported. This
may be required for NIPO Diana, which has a limit of 200 variables.

Set line length
Sets the maximum amount of characters to be used for question labels and code labels on a single
row. Rows are split using the backslash character. Sentences are split at complete words.

Open VAR file after export
Automatically opens the exported variable file in the NIPO ODIN Developer.

Unicode VAR file
Exports a Unicode variable file instead of an ASCII file (supported by Nvision Script and DSC).

25.1.1 Code Label Exports in a *FORM Question
In a *FORM question, all text of a code label (both before and after the data field) is used for the

export to NIPO Diana variables.

Exporting text of *FORM question
*QUESTION 1 *FORM

How much did you pay for:
1: Product A *NUMBER 61L3.2 Euros
2: Product B *NUMBER 6613.2 Euros

Is exported as:

*V1_1 61L3.2: How much did you pay for: Product A Euros
*V1_2 66L3.2: How much did you pay for: Product B Euros

2.5.1.2  Exports of *FORM Questions with Codes

Exports of *FORM questions using codes for fields appropriately numbers variables according to the

code numbers. The label is created from all successive text for that code.

Example script

*QUESTION 1 *FORM
What is your address?

1: Street *ALPHA 61L35in
2: House number *NUMBER 96L5
3: Postal code *ALPHA 101L10
4: City *ALPHA 111L30

Result export to NIPO Diana script

*V1_1 *TEK 61L35: What is your address? Street

*V1_2 *SNG 96L5: What is your address? House number
*V1_3 *TEK 101L10: What is your address? Postal code
*V1_4 *TEK 111L30: What is your address? City
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2.5.2 Triple-S XML

Triple-S XML is an open standard data format using XML. It is supported by a variety of products,
including but not limited to:

e Bellview

e CfMC Survent

e Merlin

e Miriad (TNS)
e Preport

e SNAP

An export to Triple-S requires that the survey data file is present in same the directory as the
questionnaire that is exported. For a questionnaire NAMEQ, the data file should be named NAME . DAT.

Export to Triple-S XML

Triple 5 XML X
Optrs
Export to Triple-5 version: 12 ~ Cancel
anc
Data file format: fixed
Save
Convert text using code page: | Cument code page w
Subsurvey |Main survey w |
Language: |Defauﬂ language e |

Include alphanumeric questions
Include questions without text and unused questions
Include null-evaluating fiter and dummy guestions
[ Recode questions containing code "0
[include open answers

Open answer length: 255

[JCheck QPS5 compliance

COpen 555 file

Export to Triple-S version
Sets the Triple-S format to use. Check your statistical analysis package for details. Supported exports
are 1.1, 1.2 and 2.0.

Data file format
Sets the data file format for the export, either fixed or csv (character-delimited). This is only

supported for Triple-S version 2.0.
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Convert text using code page
Select the code page to convert the export into. Make sure the selected code page matches the
language of your questionnaire.

Subsurvey
Select which survey to export if *NEW was used within the questionnaire.

Language
If more than one language is defined within the questionnaire, select the language to use for the
question and code labels in the export.

Include alphanumeric questions
Include *ALPHA and *NUMBER questions in the export.

Include questions without text and unused questions
Exports questions without text and questions that are never shown due to routing. By default, these
are not exported.

Include null-evaluating filter and dummy questions
Exports questions that use a filter that always evaluates to false (for example *IF [ 1 = 0])and
*DUMMY questions. By default, these are not exported.

Recode questions containing code '0'
Code 0 for code categories is by default not supported in the Triple-S XML format. This option
recodes code labels if code 0 was used in the questionnaire.

Include open answers
In addition to optionally coded open-ended questions, this exports open-ended answer verbatim
into the data file.

Open answer length

Sets the maximum number of characters to be used for open-ended answers. Answers beyond the
length limit are truncated.

Check QPS compliance

Checks compliance with Triple-S exports for QPS. If the compliance is not met, a warning message is
displayed.

Open SSS file
Automatically opens the Triple-S variable definition file in the NIPO ODIN Developer after export.

The following characters in the question and code text are escaped when exporting to Triple S XML:
e <isreplaced by s1t;
e >isreplaced by sgt;



e sisreplaced by samp;
e 'isreplaced by sapos;
e "isreplaced by squot;

2.5.3 SPSS Portable
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An export to SPSS Portable requires that the survey data file is present in same the directory as the

questionnaire that is exported. For a questionnaire NAMEQ, the data file should be named NAME . DAT.

Export to SPSS POR file

SPSS export options st
Survey Variables
Subsurvey R | [] Variable name in front of question text
LT | Default language - | [(]'Question n'in front of question text Cancel
[] Use question-D's as varable names Save
Data File [] Use altemative names for random and order variables
Write unicode data [] Wirite random and order numbers
Convert text using code page: | Cument code page [] Use code numbers for Muttiple Dichatomy fields
Retain ODIN data format Text for mentioned: | Mentioned |
Include open answers 255 Text for not mertioned: |Not mertioned |
Max record length: 95939 Variable name length: 5
Variable generation Variable: label length:
[ Include questions without text and unused questions Value label length:
[ Include null-evaluating fiter and dummy questions i )
Wariable names first letter:
Miscellanesous MNumber of chars from mutti question: E_
Include save script -
Subsurvey
Select which survey to export if *NEW was used within the questionnaire.
Language
If more than one language is defined within the questionnaire, select the language to use for the
question and code labels in the export.
Convert text using code page
Select the code page to convert the export into. Make sure the selected code page matches the
language of your questionnaire.
Retain ODIN data format
Not available for this format.
Include open answers
Not available for this format.
Page 26
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Max record length
The maximum number of positions of a single record. Check your statistical analysis software for the
limits. Longer records are split at the configured threshold.

Include questions without text and unused questions
Exports questions without text and questions that are never shown due to routing. By default, these
are not exported.

Include null-evaluating filter and dummy questions
Exports questions that use a filter that always evaluates to false (for example *IF [ 1 = 0])and
*DUMMY questions. By default, these are not exported.

Include save script
Not available for this format.

Variable name in front of question text
The question label is preceded by the export name of the variable. Optionally add a line feed to the
variable name.

‘Question n'’ in front of question text
All question texts are preceded by the word "Question" followed by the question number originally
used in the questionnaire.

Use question-ID's as variable names
If specified, use names defined with *VAR as variable names.

Use alternative names for random and order variables
Uses a slightly shorter format for *RANDOM and *ORDER variables, where the default first letter is
replaced by R or O respectively.

Write random and order numbers
Where *RANDOM and *ORDER are used with a position definition, this stores the order in which the

codes appeared during the questionnaire in an additional variable.

Use code numbers for Multiple Dichotomy fields

By default, for *MULTI questions all codes are exported as multiple dichotomy questions (mentioned
/ not mentioned). This option places the original code number in the question label for these
questions.

Text for mentioned
For multiple dichotomy questions, sets the label to be used for 'mentioned'.
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Text for not mentioned
For multiple dichotomy questions, sets the label to be used for 'no mentioned'.

Variable name length
Sets the maximum length for variable names. Choose either 8 or 64, dependent on your SPSS version

in use.

Variable label length
Sets the maximum length for the variable label (the question text). Longer texts are truncated at the
threshold.

Value label length
Sets the maximum length for the value label (the code label text). Longer texts are truncated at the
threshold.

Variable names first letter
Sets the first letter for an exported variable name. This only happens question IDs are not used, or if
the question does not have a question ID defined (*VAR).

Number of chars from multi question

By default, multiple dichotomy questions receive the full original question text in addition to the
code label. This option configures the maximum number of characters from the question label to
include.

Note:

The selected settings for variable names may cause the export to generate variable names that
exceed the maximum number of characters for the SPSS version you are using. A warning is
issued for the minimum limit for older versions - adjust the settings if required.

2.5.4 SPSS-PC

An export to SPSS-PC script files requires that the survey data file is present in same the directory as
the questionnaire that is exported. For a questionnaire NAMEQ, the data file should be named

NAME . DAT. This export creates two files: a variable definition file (sPs file) and a data file (EXT file).
Run the sps file in SPSS to create the data set.
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SPSS export options

Survey

Subsurvey v

Language: ‘De{auh language v|

Data File
[] Write unicode data

Retain ODIN data format
Include open answers

Max record length:

Variable generation
[ Include questions without text and unused questions
[ Include null-evaluating fiter and dummy questions

Miscellaneous
Include save script

Convert text using code page: | Cument code page ~

Vanables

[] Variable name: in front of question text

[[1'Question n'in front of question text

[[] Use question-ID's as variable names

[[] Use aftemative names for random and order variables
[ wite random and order numbers

[] Use code numbers for Muttiple Dichatomy fields

~

Text for mentioned:
Text for not mentioned:

Variable name length:

=)

Variable label length

i
e
@

Value label length:

Variable names first letter: n

Number of chars from multi question

Subsurvey

Select which survey to export if *NEW was used within the questionnaire.

Language

If more than one language is defined within the questionnaire, select the language to use for the

question and code labels in the export.

Write Unicode data

If you need your data in Unicode.

Convert text using code page

Select the code page to convert the export into. Make sure the selected code page matches the

language of your questionnaire.

Retain ODIN data format

Keeps the exported data file (EXT file) in the same format as the original NIPO ODIN data file (DAT

file). Included open-ended answers, if any, are appended at the end of each record.

Include open answers

Includes open-ended answer verbatim in the data file as additional variables.

Max record length

The maximum number of positions of a single record. Check your statistical analysis software for the

limits. Longer records are split at the configured threshold.

Include questions without text and unused questions

Exports questions without text and questions that are never shown due to routing. By default, these

are not exported.

Page 29
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Include null-evaluating filter and dummy questions
Exports questions that use a filter that always evaluates to false (for example *IF [ 1 = 0])and
*DUMMY questions. By default, these are not exported.

Include save script
Includes the line "SAVE OUTFILE='survey.SAV' /COMPRESSED"where survey is the name of the

survey.

Variable name in front of question text
The question label is preceded by the export name of the variable. Optionally add a line feed to the

variable name.

‘Question n’ in front of question text
All question texts are preceded by the word "Question" followed by the question number originally
used in the questionnaire.

Use question-ID's as variable names
If specified, use names defined with *VAR as variable names.

Use alternative names for random and order variables
Not applicable to Nfield.

Write random and order numbers

Not applicable to Nfield.

Use code numbers for Multiple Dichotomy fields

By default, for *MULTI questions all codes are exported as multiple dichotomy questions (mentioned
/ not mentioned). This option places the original code number in the question label for these
questions. If disabled, the dichotomy questions are renumbered and do not carry any relation to
code numbers used in the questionnaire.

Text for mentioned
For multiple dichotomy questions, sets the label to be used for 'mentioned'.

Text for not mentioned
For multiple dichotomy questions, sets the label to be used for 'not mentioned'.

Variable name length
Sets the maximum length for variable names. Choose either 8 or 64, dependent on your SPSS version

in use.

Variable label length
Sets the maximum length for the variable label (the question text). Longer texts are truncated at the
threshold.
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Value label length
Sets the maximum length for the value label (the code label text). Longer texts are truncated at the
threshold.

Variable names first letter
Sets the first letter for an exported variable name. This only happens question IDs are not used, or if
the question does not have a question ID defined (*VAR).

Number of chars from multi question

By default, multiple dichotomy questions receive the full original question text in addition to the
code label. This option configures the maximum number of characters from the question label to
include.

Note:

The selected settings for variable names may cause the export to generate variable names that
exceed the maximum number of characters for the SPSS version you are using. A warning is
issued for the minimum limit for older versions - adjust the settings if required.

2.5.5 Ascribe

Open-ended answers in NIPO Fieldwork System surveys may be coded using Language Logic's on-line
coding solution Ascribe. Ascribe imports coding projects using a proprietary (ZIP compressed) XML
format.

An export to Ascribe requires that the survey data file is present in same the directory as the
questionnaire that is exported. For a questionnaire NAMEQ, the data file should be named NAME . DAT.
Ascribe Export

Ascribe Export >

Language: Default language w

Codeframe file: |

[ ] Incremental

Cancel

Language
If more than one language is defined within the questionnaire, select the language to use for the
question and code labels in the export.
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Codeframe file

If the project was previously coded, the current questionnaire may not contain the required Code
Frames. Select the Ascribe Code Frame file to use for coding.

Incremental

Check this option if you plan to add the current export to an existing Ascribe project. Use this feature
to add new data to an existing project.

The result file is called [surveyname] setup.zip Where surveyname is the name of your survey.
See the Ascribe documentation for details on how to create a project from this file or how to add
incremental data to an existing project.

2.5.6 Quantime

An export to Quantime requires that the survey data file is present in same the directory as the
questionnaire that is exported. For a questionnaire NAMEQ, the data file should be named NAME . DAT.

Export to Quantime

Cluantime X
Options
Spljbsur\rey Main survey ~
Language: Default language ~ Sz
Convert text using code page: | Cument code page Save
Variable label length: 255
Value label length: 255
e

[[]Variable name in front of question text

[ Question n:'in front of question text

Lse varizble names

[Jinclude questions without text and unused questions

[ Include: null-evaluating fiter and dummy questions

Include questions without text and unused questions

Exports questions without text and questions that are never shown due to routing. By default, these
are not exported.

Include null-evaluating filter and dummy questions
Exports questions that use a filter that always evaluates to false (for example *IF [ 1 = 0])and
*DUMMY questions. By default, these are not exported.

Subsurvey
Select which survey to export if *NEW was used within the questionnaire.

Language
If more than one language is defined within the questionnaire, select the language to use for the
question and code labels in the export.
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Convert text using code page
Select the code page to convert the export into. Make sure the selected code page matches the
language of your questionnaire.

Variable label length
Sets the maximum length for the variable label (the question text). Longer texts are truncated at the
threshold.

Value label length
Sets the maximum length for the value label (the code label text). Longer texts are truncated at the
threshold.

Side
Defines the default left column width for the question text and code labels.

Variable name in front of question text
The question label is preceded by the export name of the variable. Optionally add a line feed to the
variable name.

‘Question n’ in front of question text
All question texts are preceded by the word "Question" followed by the question number originally
used in the questionnaire.

Use variable names
Instead of automatically assigning question variable names based on question numbers, use the
labels defined by *VAR.

Include questions without text and unused questions
Exports questions without text and questions that are never shown due to routing. By default, these
are not exported.

Include null-evaluating filter and dummy questions
Exports questions that use a filter that always evaluates to false (for example *IF [ 1 = 0])and
*DUMMY questions. By default, these are not exported.

2.6 Imports

The imports for the NIPO ODIN Developer are used to import open-ended coding projects from
Ascribe. This re-imports data previously exported to Ascribe. These imports immediately start an
export for the data analysis software selected in the import dialog.
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2.6.1 Ascribe

This imports an Ascribe export file. Once a project has been partially or fully coded in Ascribe, it may
be used to merge the coded open-ended answers back into the data file.

Since this import issues and export, it requires that the survey data file is present in same the
directory as the questionnaire that is exported. For a questionnaire NAMEQ, the data file should be
named NAME . DAT.

Ascribe import

Ascribe Import et
Questionnaire

Language: Default langquage -

[put

Inpurt file: |

[ ] Convert single to multi f coded multi

Cutput
Output format: | NIPO Diana VAR w
Concol
Language

Sets the translation to use as defined within the coding project. This only applies if multiple
translations of questions and codes have been made.

Input file
Selects the . zIP export file to use. Note that this export file must match the currently opened
questionnaire file.

Convert single to multi if coded multi
If any previously single-coded questions have been changed to multiple-coded questions, they are
converted. Otherwise, only the first selected code is accepted.

Output format
Sets the export type to be used. Confirming this dialog brings you to the relevant export dialog.

2.7 NIPO ODIN Developer Configuration
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2.7.1 Syntax Highlighting

The NIPO ODIN Developer allows for script highlighting in the script editor. You can define the editor
font and the foreground and background colors for:

o Text

e Text selection

e Number

e Comment (remarks)

e Keywords (NIPO ODIN commands)

e Routing commands

e Variable declarations

Select ODIN > Fonts... from the menu to configure syntax highlighting.

Note:
Syntax highlighting does not work in bi-directional (Hebrew, Arabic) mode.

2.7.2 Application Configuration Options

Select Settings > Options from the menu to change the application configuration options. These are
described in this section.

27.21  ODIN Options

This dialog sets various options for the pop-up menu action to insert template questions.

NIPO ODIN Developer ODIN options

MIPQ ODIM Developer Options x

Y oDin| EE:ODIN

9@ Interview System

[ CATI Length mutiple answer
@ CAawl Length open ended
@ Nfield [] Make open always mutti

.. Fragment

[ Coding System
[ Check

b Dummy Data
b-f] Editor
[y Print
[ Autosave

[ Files

Cancel Apply Help

Length multiple answer
Sets the default length inserted for multiple-coded questions.
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Length open ended
Sets the default length inserted open-ended questions.

Make open always multi
Adds *MULTT to the *OPEN question template.

27.2.2 Interview System Options

The configuration options in the Interview System section configure the application file locations for
the NIPO CATI and Nfield previews and various preview-related matters.

NIPO ODIN Developer Interview System Options

MNIPC ODIM Developer Options x

- ODIN [ Interview System
=-Fh Interview System
@ CATI General
@ Caw Run interview systems in test mode
@ CAPI Display stratification dialog
@ Nfield [] Unicode data
... Fragment
--[gh Coding Systern
- Check
-.[gh Durnmy Data
f--[ta| Editor
-[igh Print
- Autosave

@ Files

Cancel Foply Help

Interview System Options

Run interview systems in test mode
When in test mode, no result data is stored for a test interview. Otherwise, DAT-file and O-file data is
created from a preview.

Display stratification dialog
For every *STRAT command in the questionnaire, the preview asks if it should follow the routing for

'stratification reached'. Note that no stratification file or sample is tested for this option.

Unicode data
When not in test mode, this option stores the DAT-file and O-file records in Unicode.
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2723 CATI

CATI Client

Sets the location of the NIPO CATI Client application, which is required for the NIPO CATI preview. By
default, it can be found in the NIPO ODIN Developer application directory. Select ODQES . EXE for the
non-Unicode version or ODQESU . EXE for the Unicode version.

Adjustable screen size
Allows the NIPO CATI Client window to be resized. By default, the window is maximized and appears
on top of all other applications.

Single shot
If set, automatically ends the preview at the end of the questionnaire. Otherwise, it restarts.

27.2.4  How to setup the Nfield interview system

To setup the Nfield interview system (to be able to run preview interviews in Nfield),
please enter the Nfield API URL for your area:

e EU: https://api.nfieldmr.com/v1/

e Americas: https://apiam.nfieldmr.com/v1/
e Asia Pacific: https://apiap.nfieldmr.com/v1/
e China: https://apicn.nfieldcn.com/v1/

Also please enter the domain name and user name that were created for you by NIPO.


https://apicn.nfieldcn.com/v1/
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MIPC ODIN Developer Options >
=@ ODIN Gk Nfield
= Interview Syste
@@ CATI Y Mfield Api Lin
@ CAWI |I'rl't|:|s:J-Z-’.Eu:ui.rlfiv.a-I-:Imr.u::u:umﬁ.f1;-r |
[ CAPI
-k Nfield Mfield Domain
&k Fragment |Dnmain EU |
- Coding Systerm
.. Check
5 Chec Mfield User
[ Dummy Data
.7 Editor |Marks| |

Mfield Fragment Survey Name

Cancel Aoply Help

27.25 Coding System Options
The Coding System options are obsolete in this version of the NIPO ODIN Developer.
27.26 Check Options

The Check options are described in section 2.2.

2727 Dummy Data Options

This section configures the ODIN > Generate Dummy Data... feature. In particular, it specifies what
channel is assumed to create dummy data. You may opt to select the required channel if your
questionnaire contains any channel-aware routing.

Note: this generates dummy data for NFS only (not for Nfield). You can use this to check
your logic provided it is not dependent on template commands.
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NIPO ODIN Developer Dummy Data Options

MIPQ ODIM Developer Options *
o-Fgh ODIN s Dummy Data
B@ Interview System
@ CATI Channel
[ CAWI Fick the channel for which dummy data is generated
@ capl OcAT
[ Nfield @ cawl
@ Fragment (O CAPI
.. Coding System O CAS|
[ Check
We-N Durnmy Data () Stand alone
-] Editor
[ Print
[ Autosave
[ Files
£ >
Cancel Apply Help

2.7.2.8 Print Options

The Print options allow you to define some settings when printing the currently opened
questionnaire. Note that long lines are automatically wrapped.

NIPO ODIN Developer Print Options

MNIPO ODIN Developer Options *
ok ODIN L&k Print

Page Properties

Print header and footer

Prirt line numbers

-.[Fgh Coding System

-.[Fgh Check
Dummy Data
E ¥

o-f] Editor

.

- Autosave
@ Files

Gl | [ o | [P




Print header and footer
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Prints header and footer information: the questionnaire file name and a page number.

Print line numbers

Prints line numbers in front of the code lines, except where lines are wrapped.

27.29 Autosave Options

The Autosave options make the NIPO ODIN Developer save backups of changed questionnaire files

automatically at configurable intervals.

NIPO ODIN Developer Autosave options

MIPO ODIN Developer Options

oG ODIN i Autosave
5@ Interview System
.5 CATI
[ CAWI
5 caPl
-5 Nfield
@ Fragment
.[h Coding System
- Check
[ Dumrmy Data
o-Tis) Editor
-.gh Print
-
.. Files

Autosave

] Autosave every

5 minutels)

Cancel

Apply Help

Select Autosave to enable auto-saving. Optionally change the number of minutes between saves.

Once configured, Autosave saves files at the configured interval. If a file is closed in a regular fashion,

its related backup file is deleted. If execution of the NIPO ODIN Developer terminates unexpectedly,

for example due to a system crash or a power failure, the backup files can be found in the folder

where the original is saved. Auto-backups contain the extension OBK. Opening any file for which a

backup is available also opens the backup file.

2.7.2.10 Files Options

The behavior of the File > Open and File > Save dialogs can be configured in the Files options.
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NIPO ODIN Developer Files Options

MIPQ ODIN Developer Options X
-G ODIN Files
-G Interview System File types
@ CATI Types:
@ cAW Survey Files ("g,"
=lus : Lk |
@ CAPI Data Fles (u.'u." Up Add type
@ Mfield All Files ("% Down Remove type
...gh Fragment
--[gh Coding System Add fitter
g% Check Remove fiter
[ Dummy Data
.fig] Editor (] Remember last used file fiter
[ Print
[ Autosave [[] 5ave files as Unicode
B

Conos | [ ooy | [t

File types
This section allows you to configure the file types filtered by the NIPO ODIN saving and loading dialog
boxes.

Click Add type to create a new type. You are asked to specify the name of the type as it appears in
the drop-down box in the file dialogs. Note that it is good custom to include the file filters in round
brackets. Click Remove type to remove unwanted types. In addition, select a type and click Up or
Down to change its order in the list.

For every type, click Add filter to add a file filter. More than one file filter per type may be specified.
Select a filter and click Remove filter to delete it again.

Remember last used file filter
Automatically selects the last used file filter when reopening a Open or Save dialog.

Save files as Unicode
Automatically sets the file encoding to Unicode for file saves.






3. Using the NIPO ODIN Script Language

This section provides an overview of NIPO ODIN script language syntax and features.

3.1 Naming Conventions

Names of variables, subroutines and lists have to be unique and may consist of a maximum of 12
characters. Only letters, underscores and numbers are allowed. The first character must be a letter.

3.1 Questions

Question numbers are made up of positive numbers (>= 1). No alphabetic (except X, see below) or
other characters are allowed. Each question number has to be unique within one (sub-)
questionnaire. Question numbers can be used indifferently. The NIPO ODIN Developer allows you to
renumber the questionnaire, but this is not deemed necessary. Instead of numbers you can also use
the character X on each question. In this case the question numbers are not defined, and routing has
to be done afterwards. When you renumber the questions, question numbers will be inserted.

The highest question number is 2147483647.

The *QUESTION command may be abbreviated to *Q.

Example question definitions

Valid question definitions Invalid question definitions
*QUESTION 1 *QUESTION 0
*QUESTION 2 *QUESTION -2
*Q 3 *QUEST 3
*QUESTION 2501 *QUESTION 25a
*QUESTION 109 *QUESTION 10.9
*QUESTION 11001 *QUESTION 11.001
*QUESTION 102 *QUESTION 1-2
*QUESTION 2147473647 *QUESTION 2234567890
*QUESTION 1234567890 *QUESTION 1 234 567 890
Page 43
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3.1.2 Data Fields

In the NIPO ODIN Scripting Language it is not necessary to define the starting position of a data field
when you define a question. Only the length of the data field is required. NIPO ODIN keeps track of all
the positions used in the questionnaire. In the NIPO ODIN Developer, you can automatically insert the
starting positions using the Fix Positions command. The starting positions always have to be defined
for Nfield, so please always fix your positions.

In a closed, but not multiple question the number of digits of the highest code number defines the
minimum length of the data field. In a closed, multiple question the highest code number (rather
than number of codes) defines the minimum length of the data field.

In numeric questions the minimum and maximum length depend on the answer that you expect. The
maximum size is approximately 16 positions, including decimals and a floating point.

The highest position for a data field is 200.000. Make sure your analysis program can handle the data
size.

3.2 Variables

You can store a text or a value in a variable to display in a question or to use for routing. Variables
have to be defined with *VARS, *TEXTVARS before they may be used. Variable names are not case-
sensitive.

A variable can be filled with the *PUT or the *SAVE command. Its contents can be displayed with the
*2 command. Note that the contents of the variable depend on the type of variable.

A numeric variable (*VARS) may contain any value. Use the string manipulation routines to
change the on-screen appearance of numeric values. When text or a text variable is saved in a
numeric variable, the NIPO ODIN syntax check will give a warning message.

*TEXTVARS defines a text variable and may contain a text of unlimited length. The text may contain
CR/LF which will be used when displaying the variable. Variables may not contain NIPO ODIN
commands, except for *FONT.

You can also create a variable array: *Vars Brand[10] This creates one variable, an
array of 10 numbers. You can now reference each of the variables in the array as:
Brand[1l], Brand[2], Brand[3], etc.

Note:
The contents of variables are not stored in the data file automatically. So, make sure that if
you base questions or routing on a variable, you store this information in a (dummy) question.
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3.3  System Variables

In addition to custom-defined variables, NIPO ODIN recognizes system variables for various
purposes. Unless mentioned, these system variables do not need to be defined using *VARS.

3.3.1 Test Mode Aware Scripting

Test Mode Aware Scripting allows you to mark the interviews running in the test mode by using the
_ISTEST variable.
When an interview is a test interview ISTEST is set to 1(true) or to 0 (false) otherwise.

Example routing for Test Mode Aware Scripting

*QUESTION 1 *CODES 61L1 *IF [ ISTEST ]
This question will appear only for test interviews

1: OK

*QUESTION 2 *CODES 62L1
This question will appear on all platforms
1: OK

Note: When running the preview or test link with a script that includes ISTEST, if the interviewer
halts for 15 minutes or more at a screen, the interview gets suspended. If one then resumes the
interview, all statements under _ ISTEST condition are skipped.

3.3.2 Repeat Number

The operator 2R contains the current value of a *REPEAT loop, a number between and including 1
and n where n is the value specified at the *REPEAT statement. Note that this is not the iteration
number - for example, in the third execution in the loop the value of 2R is not necessarily 3. This is
especially true for randomized, controlled, or rotated loops.

In nested blocks, the operator 2R returns the value of the loop where it is located. To access values
from loops above or below the current one, you should use a question or a numerical variable to
pass the value. The operator does not exist outside the scope of a *REPEAT block.

?R is a system variable and can not be changed (for example by using *SAVE or *PUT) nor can it be
displayed directly in question text using the *? command. Copy the value to a variable another
variable to access it (e.g. *PUT Temp [?R]).

Example using the repeat number
*TEXTVARS paper

*QUESTION 2 *CODES L7 *MULTI
Which of the following newspapers do you know?

1: La Repubblica

2: La Stanza
3: The Mirror
Page 45
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4: The New York Times
5: Le Figaro

6: La Libération

7: None *NMUL

*REPEAT 6 *CONTROL Q2 W
*PUT paper Q2, 2R

*QUESTION 3 *CODES L1
How often do you read *? paper?

1: Daily

2: Once a week
3: Once a month
4: Don’t know

*ENDREP

In nested blocks you have to transfer the repeat number 2R of the outer block to a numeric variable

first to be able to use it in the inner block.

Example storing the repeat value

*VARS X,Y,Z

*REPEAT 3

*PUT X [?R]

*REPEAT 2

*PUT Y [?R] ** this line is only necessary to display the value of 7R
*PUT Z [X+?R] ** or *PUT Z [X+Y]

*QUESTION 1

KX+ XY =*2Z

*ENDREP
*ENDREP

3.3.3 Timer

Please note that timer only works in CAPI.

Stopwatch[3] can be used as a timer that you have to reset yourself setting the value to 0. This
timer starts as soon as the interview is started or once it is reset.

The script below uses the timer to measure the time of selecting a code, pressing enter and
measuring the length of a (section of) an interview.

Timers Example

*PUT Stopwatch[3] [0]
*QUESTION 1 *CODES L1
This is a question.

1: Continue
*PAGE
The total time to conduct this interview was *? Stopwatch[3] seconds
*END
Page 46
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33.4 Elapsed Time Function

To know how much time a respondent spend answering a (set of) question(s) there is a function
?Elapsedtime (QuestionID).

It measures the time spent on a question: if the same question has been visited multiple times, it
holds the total time spent. This functionality also simplifies checking how long certain sections of
your questionnaire take so that you can detect the so called “speeders”.

This function takes a list of question IDs separated by comma(s) as an input and returns the sum of
time spend on those questions. That number matches the elapsed time you would find in the audit

log.

Example 1
*TEMPLATE NfieldChicago

*QUESTION 1 *CODES 61L1 *ID FirstQ
First question

1:0k

2:no

*QUESTION 2 *CODES 62L1 *ID SecondQ
Second Question

1:0k

2:no

*QUESTION 3 *CODES 63L1 *ID ThirdQ

Third Question
1:0k
2:n0
*VARS EsTQ[4]
*PUT EsTQ[1] [?ELAPSEDTIME(Q{FirstQ})]
*PUT EsTQ[2] [?ELAPSEDTIME(Q2)]
*PUT EsTQ[3] [?ELAPSEDTIME(Q3)]
(411

*PUT EsTQ[4] [?ZELAPSEDTIME(Q1,Q {SecondQ},Q3)]

*PAGE

First Q: *?EsTQ[ 1]
Second Q: *?EsTQJ[2]
Third Q: *?EsTQ[3]
Total Q: *?EsTQ[4]

For repeated questions, like repeat blocks or subroutines we have the following rule:
e |[f ?Elapsedtime () is executed within a *REPEAT or a subroutine, it will return the value
for that iteration (for a *REPEAT) or the value for that instance (for a subroutine).
e |Ifelapsed time is called outside of *REPEAT or subroutine, while the question itself is in
one of these, it will return the sum of elapsed times for every iteration or instance of that
question so far.

Example 2
*TEMPLATE NfieldChicago
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*PAGE
Now let's do a repeat.

*REPEAT 2 *FIELD 70L2

*VARS RepNum
*PUT RepNum [?R]

*QUESTION 4 *CODES IL1 *ID RepeatQ
Question for repeat iteration *? Repnum
1:0k

2:no

*VARS ETRepQ
*PUT ETRepQ [?ELAPSEDTIME(Q{RepeatQ})]

*PAGE
The question in this repeat took *? ETRepQ seconds

*ENDREP

*VARS ETTotalRepQ
*PUT ETTotalRepQ [?ZELAPSEDTIME(Q {RepeatQ})]

*PAGE
The whole repeat took *? ETTotalRepQ seconds.

Note: if a question is skipped due to routing, the ?Elapsedtime () will return 0 for that question.

335 Language

The LANGUAGE variable contains the name of a define language section currently in use. See the
*LANGUAGE command for more details.

3.4  Expressions

NIPO ODIN supports the use of expressions in questionnaires. An expression may indicate all sorts of
data but will always result in a value. Expressions are used in two different ways:

e Asa boolean; the result of the expression is either false (the expression has as result value 0) or
true (the expression has as result the value 1).
e To make calculations or manipulations with a value as result.

Some commands will require or allow for an expression as argument. Expressions have to be
enclosed in square brackets.

Expressions are evaluated from left to right and operators apply to the operands immediately left
and right. NIPO ODIN expressions do not follow the regular precedence rules! If a left-to-right
evaluation is not appropriate, you can use parenthesis to evaluate an expression first.
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3.41 Expression Operators

Expression operators

Operator Description (V) Note
Q Question reference On Reference to question n or its
contents
Length of field nLm Position n, length m
F Field test OxFn Contents of field (cell) number n

within form-question x

S Refers to the statement in a matrix ~ QxSn Answer of question x for the nth
statement

, code-test 0%, n 1if present, otherwise 0

- code-string Ox,n-m Code string

- minus sign -n Negation of n

# not #0x 1if no answer in question x,
otherwise 0

# negation #n 1if value n not true,
otherwise 0

+ add n+m Sum ofnand m

- subtract n-m Difference of n and m

* multiply n*m Product of nand m

/ divide n/m Division of n and m

8 exponent n*m Exponent m of n

& logical AND nem 1if both not 0, otherwise 0

\ logical OR n\m 0 if both 0, otherwise 1

RAN random value RAN n Random value from 0 up to and
including n-1

= equal to n=m Results in 1if true or 0 if false

< less than n<m Results in 1if true or 0 if false

> more than n>m Results in 1if true or 0 if false

<= less than or equal to n<=m Results in 1if true or 0 if false

>= more than or equal to n>=m Results in 1if true or 0 if false

Page 49
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Operator Description [VEY) Note
<> not equal to n<>m Results in 1if true or 0 if false
Returns the value for a value pair from a
?JSON JSON string ?JSON (JSONString, “Valu Will not return anything if the
eName” ] ValueName does not match or the

JSONString is an invalid JSON

Returns the number of the button if

?BUTTON (Qn) the question was answered with a *IF [?BUTTON(Q1l) = 2]  Number of the button if the
button. *GOTO 2 question was answered with a
button, or -1 if the button was not
used.
?R repetition number ?R current (logical) repetition number
TO Range nl TO n2 Range n1through n2
; separate ranges nl TO n2 ; n3 TO n4 Range n1through n2 or n3 through
n4
0xM order of mentionsina *MULTI 0xM
question
OxR display order of a question, when OxR
using *RAN ofr *ROT
QxMy order of mentioned numbery ina QxMy
*MULTI question. Returns the code (see example below)
number of the y mentioned from
question x.
OxRy display order Used in combination OxRy

with *ORDERnumber y of a question,
when using *RAN or *ROT. Returns
the code number of the y

randomized or rotated.

Question reference

The reference to a question by means of on where n represents the question number. For example,
010 references question 10. If it concerns a code test then more code values may occur; these will be
treated as a logical or.

Code string

Any given number of codes separated by one or more commas or a code range indicated by a dash.
Valid codes consist of the digits 0 up to and including 9, or B for a blank value. For example, 02, B
returns 1 (true) is Q2 is blank, 93, 1-5 returns 1if in Q3 any of the codes in the range 1-5 are marked,
and Q4, 2,4, 8,12 returns 1if Q4 contains any of the codes 2, 4, 8, or 12 ar marked.

Page 50
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Values norm

The values n or m may represent any of the following:

e Number

e Expression or variable

e Text enclosed in double quotes with, possibly, the embedded contents of a variable

Example of usage QxMy

Out of 5 choices in a multiple question 1, the user asked to select between three and five options. In
question 3, the first 3 selected options are shown in the order of selection (the 1 selected option is

shown on top, the 2" is shown below it, etc.).

*QUESTION 1 *CODES 61L5 *MULTI
Please choose at least 3 options

1: one

2: two

3: three

4: four

S: five

*QUESTION 2 *CODES 66L5 *MULTI *DUMMY
1: one

2: two

3: three

4: four

5: five

*INCLUDE Q2 [QIMI]
*INCLUDE Q2 [Q1M2]
*INCLUDE Q2 [Q1M3]

**Display to the user the 1st 3 selected choices in order of selection.
*QUESTION 3 *CODES 88L9 *MULTI *CONTROL Q2 W *ORDER Q1M
1: one

2: two

3: three

4: four

S: five

3.4.2 Examples of Expressions

Examples of expressions are presented here. Note that expressions are always specified between
square brackets. The expressions in these examples may be either assigned to a variable or applied
to an *IF filter.

Expression Examples

Expression Results in

[ 100 ] The value 100.

[ RAN 100 ] A random between 0 and 99 inclusive.

[ Totall3] ] The value stored in the third element of the number array TOTAL.

[ TOTAL2 * 3 + 10 ] the value stored in the variable TOTAL2, multiplied by 3 and then increased by 10.
Page 51
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[ Q11,1 ]

[012,1,2,3 ]

[ 013 >= 18 ]

[ 011,1 \ 012,1,2,3 1

[ 012,1,2,3 & Q13 >= 18

[ 012 ]

[ 013 = Q14 ]

[ #(Q5 \ Q6) & Q7

1
=

[ Q5 , 1 TO 3 ]

[ Q5 , 1 TO 3 ; 6 TO 8]
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1if code 1was marked in Q11, otherwise 0.

1if any of the codes 1, 2 or 3 were marked in Q12.

1if the value in Q13 is equal to or larger than 18.

1if code 1is marked in Q11 or if code 1, 2 or 3 is marked in Q12.

1if code 1, 2 or 3 is marked in Q12 and Q13 is equal to or larger than 18.

The value of Q12 if Q12 is a single-coded or numerical question; the highest marked

code if Q12 is a multiple-coded question.
1if the (highest) value of Q13 is equal to the (highest) value of Q14

1if either Q5 or Q6 does not contain a value and Q7 equals 1. The brackets are

required to let the expression evaluate Q5 and Q6 first.
1if any of the codes 1, 2 or 3 are marked in Q5.

1if any of the codes 1, 2, 3, 6, 7, or 8 are marked in Q5.

3.43 Common Mistakes in Expressions

This section describes common mistakes made in expressions, where a syntax check does not reject

the syntax used but where a misunderstanding exists on how the expression is evaluated. These

examples focus of filtering constructions.

Incorrect expressions and how to correct them

Incorrect expression What it was intended to do What it does Correct expression
*IF [20 < Q2 < 40] Check if Q20 is between the This firsts checks if *IF [ Q2 > 20 & Q2 < 40 ]
values 20 and 40. 20 is smaller than

Q2 (result 0 or 1)
then if the result is

smaller than Q0.
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*IF [Q20,3\4\5] Check if Q20 has code 3, 4 or 5

marked.

*IF [ Q21=1,2,3 1 Check if Q21 has code 1,2 or 3

marked.

*IF [ Q21 = 1-3 ] Check if Q21 has code 1,2 or 3

marked.

*IF [ #021 = 1 ] Check if Q21is not equal to 1

3.5
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This checks if Q20 *IF [ Q20,3,4,5 ]
has code 3. Then it

checks if either the

result of the

expression, or 4, or

5 are true. Any value

above 0 is always

considered true,

therefore the

expression always

results in 1.

This checks if Q21is  *IF [ 021,1,2,3 ]
equal to the

expression 1,2,3. The

latter expression

checks if position 1

in the DAT-file

containsa2ora3.

This checks if the *IF [ 021,1,2,3 ]
value of Q21 equals

-2 (1-3).

This first checks if *IF [ Q21 <> 1 ]
Q21is not empty,

then compares the

result to 1. In other

words, the

expression returns 1

if Q21 is not empty.

String manipulation routines

NIPO ODIN includes a set of routines for text (string) and text variable manipulation. These routines

can be used for various purposes, including (but not limited to):

e Checking if a string meets the requirements for input. For example, a routine to check the

respondent input is an Email address with valid syntax.

e Reformatting text to make it more suitable for displaying the text in follow-up questions.

e Reformatting text to make it more suitable for storage in output data.
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e Checking if a text has certain text (pattern) matches, for example for finding answers in *OPEN
ended questions.

NIPO ODIN considers strings as ranges of unique characters and is therefore indifferent to code page
use.

All string manipulation routines expect a text variable or a static text string as input parameter. If the
answer to a question must be checked, use *SAVE or *PUT to store the answer in a text variable first.
Strings routines are considered expressions, and therefore always require square brackets to be
evaluated.

3.5.1 STRFINDMATCH

Syntax

?STRFINDMATCH (<string>, <regex>)

Description

Returns a substring from a string that matches the first occurrence of a regular expression. If no
match is found, an empty string is returned. NIPO ODIN follows the Microsoft regular expression
implementation. Regular expressions are a powerful tool to find particular texts in an answer given
by a respondent by using matching patterns rather than literal text. A complete reference for these
regular expressions can be found on the Microsoft Developer Network
(http://msdn.microsoft.com/en-us/library/az24scfc.aspx).

Arguments

<string>

String to search for the regular expression.
<regex>

Regular expression that the substring must match.

Example

The following example retrieves the first number found in an open-ended answer.

*VARS value
*TEXTVARS answer

*QUESTION 10 *OPEN L1 *SAVE answer
Let me find the value in your text:

*PUT value [?STRFINDMATCH(answer,""\d+")]

*Q 20
Value found: *? value


http://msdn.microsoft.com/en-us/library/az24scfc.aspx
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3.5.2 STRHASMATCH

Syntax

?STRHASMATCH (<string>,<regex>)

Description

Checks if a string matches a regular expression. Returns 1 if true, 0 otherwise. NIPO ODIN follows the
Microsoft regular expression implementation. Regular expressions are a powerful tool to find
particular texts in an answer given by a respondent by using matching patterns rather than literal
text. A complete reference for these regular expressions can be found on the Microsoft Developer
Network (http://msdn.microsoft.com/en-us/library/az24scfc.aspx).

Arguments

<string>
String to search for a match with the regular expression.
<regex>

The regular expression to search for.

Example 1

The following example ensures an answer only contains letters and digits.
*TEXTVARS zipcode

*Q 10 *ALPHA L4 *SAVE zipcode
Please enter your zip code:

*Q 20 *CODES L1 *IF [?STRHASMATCH(zipcode,"\W")]
A zip code may only contain characters and letters.

1: Go back and correct * BACK 10

Example 2

This more advanced example uses a regular expression that checks the syntax validity of the Email
address.
*TEXTVARS email

*Q 10 *ALPHA L40 *SAVE email
What is your Email address?

*PUT email [?STRLOWER(?STRTRIM(email))]

*Q 20 *CODES L1 *IF [#(?STRHASMATCH(email,"*([a-z0-9_\.-]H)@([\da-z\.-]+)\.([a-2\.]{2,6})$"))]
It appears that *?email is not a valid Email address.

1: Go back and correct *BACK 10

3.5.3 STRINDEX

Syntax

?STRINDEX (<string>,<findstring>)


http://msdn.microsoft.com/en-us/library/az24scfc.aspx
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Returns the start position of a substring in a string, or 0 if the substring was not found. The match

must be case-sensitive. Note that 1indicates the first position of a string.

Arguments

<string>

String in which to search.
<findstring>

String to search for.

Example

*TEXTVARS answer
*Q 10 *OPEN L1 *SAVE answer
What is your opinion of the European Union?

*Q 20 *IF [?STRINDEX (answer,"!")>0]

You seem to have formed a strong opinion on the subject.

3.5.4 STRLENGTH

Syntax

?STRLENGTH (<string>)

Description

Returns a number indicating the length of the specified string or text variable.

Arguments

<string>

String to calculate the length of.

Example

*TEXTVARS zip
*Q 10 *ALPHA L4 *SAVE zip
Enter the zip code:

*Q 20 *CODES L1 *IF [#(?STRLENGTH(zip)=4)]
The zip code must be 4 characters or digits!

1: Go back *BACK 10

3.5.5 STRLOWER

Syntax

?STRLOWER (<string>)



Description

Convert a string to lowercase.

Arguments

<string>

String to convert to lowercase.

Example
*TEXTVARS email

*Q 10 *ALPHA L40 *SAVE email
What is your Email address?

*Q 20 *ALPHA L40 *DUMMY
Email in lowercase

*COPY Q20 [?STRLOWER (email)]

3.5.6 STRREPLACE

Syntax

?STRREPLACE (<string>)

Description

Replaces text in a string.

Arguments

<string>

String in which you want to replace some characters.
<findstring>

The exact sequence of characters you want to replace.

<replacestring>

The exact sequence of characters you want as a replacement.

Example
*TEXTVARS OriginalString, FindString, ReplacementString, ResultString

*PUT OriginalString "Hello World"
*PUT ResultString [?STRREPLACE(OriginalString, "World", "Universe")]

*PAGE

*?0riginalString
*7ResultString

Please note:
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e The <string>and <findstring> parameters cannot be empty.

e The function is case-sensitive.

e If the answer to a question must be checked, use *SAVE or *PUT to store the answer in a

text variable first.

e String manipulation routines are considered expressions, and therefore always require

[square brackets] to be evaluated.

3.5.7 STRSUBSTR

Syntax

?STRSUBSTR (<string>, <start>,<length>)

Description

Returns a substring of a string.

Arguments

<string>

String to return a substring of.
<start>

Start position of substring in the string.
<length>

Number of characters to return, starting from the start position. Use -1 to return the substring from

the start position until the end of the string.

Example

*VARS len
*TEXTVARS answer

*REPEAT 10
*Q 10 *OPEN L1 *SAVE answer

This is the echoing question. Type something.

*PUT len [?STRLENGTH (answer)]
*PUT answer [?STRSUBSTR (answer,len/2+1,-1)]

*Q 20
... ¥? answer...

*ENDREP

3.5.8 STRTRIM

Syntax

?STRTRIM (<string>)



Description

Removes leading and trailing spaces from a string.

Arguments

<string>

The string to trim.

Example
*TEXTVARS name

*Q 10 *ALPHA L40 *SAVE name
What is your name?

*PUT NAME [?STRTRIM (name)]

*Q 20
Welcome to the questionnaire, *? NAME.

3.5.9 STRUPPER

Syntax

?STRUPPER (<string>)

Description

Convert the string to uppercase.

Arguments
<string>

String to return in uppercase.

Example
*TEXTVARS answer

*Q 10 *OPEN L1 *SAVE answer
What brand is your smartphone?

*PUT answer [?STRUPPER (answer)]

*Q 20

The following questions evaluate your experience with your *?answer.

3.6 Form Field References
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Expressions may refer to fields in a *FORM question using the F operator.
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Example of *FORM field references

*Q 10 *FORM *CONTROL Q5 W
At the garden center, how many items did you buy of each?

1: Flowers: *NUMBER L2 5: Flower price *NUMBER 12.2
2: Trees: *NUMBER L2 6: Tree price  *NUMBER 1L2.2

3: Rakes: *NUMBER L2 7: Rake price *NUMBER L2.2
4: Shovels: *NUMBER L2 8: Shovel price *NUMBER L2.2

*VARS items
*PUT items [Q10F1+Q10F3+Q10F5+Q10F7]

The references with operator ¥ do not refer to the codes used in the *FORM question, but to the
index of the field when searching for fields from the top-left to the bottom-right of the screen in
rows. In other words, the field behind "Flowers" is field 1, the field behind "Flower price" is field 2, the
field behind "Trees" is field 3 and so forth.

Field numbers do not change even if fields are hidden using the *CONTROL command. For example,
field 6 remains field linked with "Rake price" regardless of using *CONTROL.

A reference to a field that does not exist in the *FORM question will always receive to the value of the
first field in the question, regardless of whether that field was shown. For example, Q10F10 or
010F15 would both refer to Q10F1.

Fields can also be referenced to copy values into:

Copying values into fields

*COPY Q10F1 [50]
*COPY QI0F2 [1.25]

Field indexes may be referenced using a variable or an expression. The following is valid syntax to
add all price values:

Referencing fields using the repeat number

*VARS totalprice
*put totalprice [0]
*REPEAT 5

*put totalprice [totalprice+Q10F(2*?R)]
*ENDREP

However, variables or expressions may not be used to store values into the fields. The following
syntax is invalid:

Invalid field reference syntax

*REPEAT 8
*COPY QIOF(?R) [0]
*ENDREP
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3.7  Custom Properties

3.71 Overview

Custom properties are useful way of defining and storing user specific information at
question/categories/list level. This feature has high potential and use in automation where
information/resources are picked up based on request/user input from global setup/repository.
They are also useful in driving variable content in the script.

3.7.2 Custom Properties in Nfield

NIPO ODIN uses the *PROPERTTES command to attach properties to questions and categories, and a
property function to query properties. These properties are intended for segmentation and querying
and filtering on questionnaire properties in the reporting phase. The categories’ properties can also
be used for filtering in the questionnaire script with the property function in expressions and as an
additional argument with *USELIST.

Custom properties, in Nfield, are little different than the way they are used in Dimensions. Nfield
allows little freedom in terms of where & how you can use them however that doesn’t limit the
alternate ways of using it.

373 property() Function

A built-in function has to be called for fetching values of custom properties. This function
needs few compulsory arguments. Below describes how it should be used in ODIN script —

?property (Q[question number], [category number], "key")

property () is a function to fetch the custom prop values. It cannot be used without
passing arguments.

Q[gquestion number] isa question from which custom prop value it to be fetched.

[category number]is a category name (response index) which will be fetched from
the above-mentioned question. This is numeric index passed with categories. The category
number can also be an expression.

Key is aname of custom property value of which is to be fetched in.
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Example 1

*TEXTVARS moodtype
*PUT moodtype [?property(Q1, Answer, “Feeling”]

Since it is a function, it returns property value as text type which is to be stored into text variable
before use. You can directly use the function as per your needs. The function can also be used as
expression under conditional statements.

Example 2

*IF [?property(Q1, Answer, “mood”) = “Bored”]

Example 3

Filtering a question based on custom property defined in other question

*VARS Answer

*QUESTION 1 *CODES 61L1 *PROPERTIES “segment=hotel” *SAVE Answer
How will you rate the service during your stay at hotel Marriot?

1: Very Good *PROPERTIES “emotion=Positive;mood=Happy”

2: Good *PROPERTIES “emotion=Positive;mood=Happy”

3: Average *PROPERTIES “emotion= Negative;mood=Bored”

4: Bad *PROPERTIES “emotion=Negative;mood=Bored”

*QUESTION 2 *OPEN 62L1 *IF [?property(Q1, Answer, “mood”) = “Bored”]
What was that which made you feel bored?

Here Question 1 is about rating the overall service at hotel Marriot. The answer (index)
is saved in a variable (Answer) which was later used in property () to fetch the value
of custom property mood.

Next question (Q2), is filtered on custom property mood and asked only if respondents
have felt bored (i.e. value of custom property mood).

Example 4

Summarizing (netting) the responses of one question into other dummy (summary) variable at back

of script.

*VARS Answer, propval
*QUESTION 1 *CODES 61L2 *SAVE Answer
Please enter region you live in.

1: Schleswig-Holstein *PROPERTIES “DE Reg=1"
2: Hamburg *PROPERTIES “DE Reg=1"
3: Niedersachsen *PROPERTIES “DE_Reg=1" 4: Bremen *PROPERTIES
“DE Reg=1"
5: Nordrhein-Westfalen *PROPERTIES “DE_Reg=2"
6: Hessen *PROPERTIES “DE_Reg=3"
7: Rheinland-Pfalz *PROPERTIES “DE_Reg=3"
8: Saarland *PROPERTIES “DE_Reg=3" 9: Baden-Wurttemberg
*PROPERTIES “DE_Reg=3"
10: Bayern *PROPERTIES “DE_Reg=3"
11: Berlin *PROPERTIES “DE_Reg=4"
12: Mecklenburg-Vorpommern *PROPERTIES “DE_Reg=4"
13: Sachsen-Anhalt *PROPERTIES “DE_Reg=4" 14: Brandenburg
*PROPERTIES “DE_Reg=4"
15: Thuringen *PROPERTIES “DE_Reg=4"
16: Sachsen *PROPERTIES “DE_Reg=4"
*QUESTION 2 *CODES 63L1 *DUMMY
1: North
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2: West
3: South
4: East

*PUT propval [?PROPERTY(Q1, Answer, “DE_Reg”)]
*COPY Q2 [propval]

*PAGE
propval = *? propval
Answer = *? Answer

Here Question 1 (region) is asked from respondent, and zone at Question 2 is
back-coded using custom properties defined at Question 1.

There could be many ways of implementing it using custom properties; this is just one way
to fulfill the requirement of summarizing regions into zones.

Example 5

Use in multi-language projects the property for the data in the sample rather than the category text
for quota control purposes.

*SAMPLEDATA sGender

*VARS ansQ102

*QUESTION 102 *CODES L1 *SAVE ansQ102
Select your gender.

1: male *PROPERTIES "gender=Male"
2: female *PROPERTIES "gender=Female"

*PUT sGender [?PROPERTY(Q102, ansQ102, "gender")]

*LANGUAGE Dutch
*QUESTION 102
Kies uw geslacht.

1: man
2: vrouw

3.7.4 In *USELIST command

Properties can be used to filter the categories shown in questions with the *USELIST command. When
more than one property is specified they are combined with a logical and.
Syntax

*USELIST "ListName({, [propertyl=[value]}{; [propertyl=[value]l}{;...}"

Example

Display in a question only the categories available in their region.

*LIST "Outlets"

1:Outlet 1 *PROPERTIES "nl=Y ;be=N;de=N"
2:Outlet 2 *PROPERTIES "nl=N;be=Y;de=Y"
3:Outlet 3 *PROPERTIES "nl=Y ;be=Y;de=N"
4:Outlet 4 *PROPERTIES "nl=N;be=N;de=Y"
5:Outlet 5 *PROPERTIES "nl=N;be=N;de=Y"
6: Outlet 6 *PROPERTIES "nl=Y;be=Y;de=Y"

*QUESTION 101 *CODES L1
Choose your country



1:Belgium *PROPERTIES "country=be”
2:Germany *PROPERTIES "country=de”
3:Netherlands *PROPERTIES "country=nl”

*TEXTVARS sCountry
*PUT sCountry [?PROPERTY(Q101, Q101, "country")]

*QUESTION 201 *CODES L1
Which outlet did you visit?

*USELIST "Outlets, *? sCountry=Y"

3.7.4.1 See Also

*PROPERTIES 214
*USELIST 282

Using the NIPO ODIN Script Language
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3.8 Date Functions

3.8.1 Overview
Date functions are designed to make calculation of dates easier.
We accept 2 date/time formats for the date functions:

1. YYYY-MM-DD HH:MM:SS(+offset), where the offset is optional. So
[2023-09-12 12:30:45+0400] or [2023-09-12 12:30:45]

Or

2. The native Nfield format produced by the *DATE command when stored in a text variable:
[2024/07/15 20:30:18 +060 2]. Date functions will ignore the day of week from this
format.

3.8.2 Adding Seconds to a Date

?DATETIMEADD (<datetime>, <offset>)

The offset is offset from the <datetime> in seconds. If you want to add 10 minutes to the
date , the offset needs to have a value of 600. Negative numbers are allowed to subtract
data.

The result will be a new datetime value, with the same format as the input <datetime>
value.

Example:
*PUT NewDate[?’DATETIMEADD(OldDate, Seconds)]

Where NewDate will hold the O1dDate plus the Seconds.

3.83 Calculating the Time Difference Between Two Dates

?DATETIMESPAN (<datetimel>, <datetime2>)

Example:
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*PUT TimeDifference [?DATETIMESPAN (datetimel, datetime2)]

Where TimeDifference will hold the seconds between datetimel and datetime?2. Both
datetime formats need to be exactly the same, including the of fset if included. The result will be
the difference in seconds obtained by doing <datetimel> - <datetime2>.

3.8.4 Obtaining the Day Number of the Week

?DATETIMEDAYOFWEEK (<datetime>)

Example:
*PUT WeekDay [?DATETIMEDAYOFWEEK (datetime)]

Where WeekDay is a number, which maps to a day-of-the-week. 1 through 7, Monday to Sunday.

Note: the native *DATE command also gives the number of the week day, when stored as an index
variable, but it counts from Sunday to Saturday.

3.85 Obtaining the Week Number

?DATETIMEWEEKNUMBER (<datetime>)

Example:
*PUT WeekNumber [?DATETIMEWEEKNUMBER (datetime)]

Where Weeknumber holds the number of the week.
Weeknumber is according to the ISO 8601 specification, which describes the following:

The week number can be described by counting the Thursdays: week 12 contains the
12th Thursday of the year.

The ISO week-numbering year starts at the first day (Monday) of week 01 and ends at
the Sunday before the new ISO year (hence without overlap or gap). It consists of 52
or 53 full weeks. The first ISO week of a year may have up to three days that are
actually in the Gregorian calendar year that is ending; if three, they are Monday,
Tuesday and Wednesday. Similarly, the last ISO week of a year may have up to three
days that are actually in the Gregorian calendar year that is starting; if three, they are
Friday, Saturday, and Sunday. The Thursday of each ISO week is always in the
Gregorian calendar year denoted by the [SO week-numbering year.
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4. Quota

4.1 NIPO Academy Sessions on Quota

We strongly recommend that you watch the four NIPO Academy sessions on quota that we've created
here (sessions 51 through 54) to get a thorough introduction to quotas from basics to advanced.

Session 54 is specifically devoted to quota problems we often see at NIPO helpdesk. So, if you have a
problem with quotas, please first check this video to see if your problem is mentioned. If yes, follow
the steps in the video to solve it, and only in case it still does not work for you contact the NIPO
helpdesk with full details of what you have done already and what the outcome was.

4.2 What is Quota?

A quota is a subset of respondents with specific characteristics, such as a common zip code, city,
gender, or age group. In Nfield Manager, we can create quota frames and specify the specific subsets
of respondents we are looking for and how many of each subset we need for our project. Here is an
example of a simple quota frame:

Total Target: 100
Age: Below 35 40 (min)
Age: 35 and above 40 (min)

In this case 100 respondents will be interviewed: at least 40 aged below 35, 40 older ones, and 20 that
could be any age.

So, a quota frame is the entire quota setup for a project.

A total Target is the required number of interviews for the entire quota frame. In our example, 100.
A quota variable is the criteria we use to subdivide the quota frame for the project, in this example,
Age. Quota variables are used in the ODIN script as sample variables.

Quota levels are the cells that make up to the quota variable. In our example, for the quota variable
Age, there 2 quota levels: ‘Below 35’ and ‘35 and above’.

Level Target - required number of interviews for a specific quota level. Sometimes we just call the
level target “quota” for that level. In our example, both quota targets are equal to 40.

The quota count for a level increases by 1 when an interview for that quota is successfully completed.

This is what the ODIN script for this quota would look like:

*SAMPLEDATA age

*QUESTION 1 *CODES 101L1

Are you above or below 35 years old?
1:Below 35

2:35 and above


https://nipo.com/services/academy-videos
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*IF [Q1,1] *PUT age "below 35"
*[F [Q1,2] *PUT age "35 and above"

4.2.1 Steps to Create Quota Frame

Let us take another example, where the requirement is to interview a number of respondents in each
of several different age groups, and certain number of them have to be males, and others -- females.

To create the quota for this survey, we would first need to define a quota frame for it in Nfield. This is

done in 3 steps:

1. Define quota variables & levels;
2. Order variables;

3. Define targets.

The quota variables and levels that you define in Nfield Manager need to be called exactly the same
as in the ODIN script (they are case sensitive). When you enter a quota variable name, the Nfield
Manager automatically suggests a questionnaire variable name for you.

4,22 How to Define Quota Variables and Levels

To define the quota variables and levels:
1. In Nfield, go to the Quota tab of the Setup Survey left-side menu.
2. Click on Add a Quota Variable link.
3. Add the quota variable “Gender”, and then the level “Male”.
4. Click on the plus button to add another level, “Female”.

5. Repeat for the “Age”.
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GENERAL QUESTIONNAIRE QUOTA FIELDWORK
o Define variables & items o Orde
& Back to surveys
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Variable name
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If you need to set up a large quota frame, you can create a list of quotas in Word, Excel,
or the Notepad containing the variable names and level names and copy and paste directly

into the quota frame.

Place each variable and level on a separate line in your source file, as shown in the

example. The first item is always the Variable name:

Syntax:
Variable name
Level value Label

Level value Label
Level wvalue Label

Example:
City
Hyderabad

Amsterdam
Madrid

Place your cursor on the Variable name input as shown in screenshot below, then copy the quota

cells from your source file and paste them in using CTRL-V or right click-Copy:
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General Questionnaire Quota Fieldwork Retention
Version() Online Under construction
Quota Add variable [
n Define Variables & Items B Order & Nest Variables B Define Targets
Variable name Multi &
| Place your cursor here <3 @ Questionnaire variable 7 » [ |
T, Level value label g

Add variable

Order & Nest Variables

To copy only the levels: Place your cursor on the Level value label input as shown in the
below screenshot, then copy only the levels needed from your source file (excluding the
variable name) and paste them:

General Questionnaire Quota Fieldwork Retention
\ersionQ) Online Under construction
Quota Add Variable
B Define Variables & Items B order & Nest Variables B Define Targets
Variable name Multi E8
| (2] Questionnaire variable @ » [}
1, Place your cursor here <: o

Add Vvariable

If one of your quota variables allows for multiple answers (the users are allowed to
select/satisfy multiple sub-quotas for this variable), please move the Multi toggle to “On”
position (as in example below):



L) q‘ammzowczwn] [0 e Manager - Quot X [EES

N

O @

4y

Back to surveys

Setup survey

Sample and Invitations

[)- [ -3

ol Monitor fieldwork

blue-glu-manager.niposoftware-dev.com/surveys/176440b6-e6/0- 4eB7-a416- 74

GENERAL QUESTIONNAIRE QUOTA FIELDWORK

€ Dctine variables & tems &

Brand
Brand1
Brand2

Brand3

Female
Male

ADD VARIABLE

ORDER & NEST VARIABLES

Please note: you can also perform all the steps above through the script. See section *QUOTA.

4.2.3

The next step is to organize your quota variables. You can change the order of quota

variables, and define if and how they interlink.

How to Organize and Order the Quota Variables

Quota

In our example we have created two quota variables “Gender” and “Age”. If these are
separate quota variables, your frame structure would look like this (two variables, each

with two levels):

Gender

Male

Female

Age

below 35

35 and above

Any targets you would put in this quota frame would be evaluated per variable and level.

You can also make these two variables interlinked. Interlinked quota variables mean that
“Gender” and “Age” are evaluated in combination of each other, like this:

Gender & Age
Male & below 35 Male & 35 and above
Female & below 35 Female & 35 and above
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In “Order and nest variables’ each quota variable (Gender/Age) is represented by a green
box. You can move the boxes up or down to reorder them. Or, using the arrows on the left
and right side of each box <> you can make the quota variables interlinked (move one
under the other).

Questionnaire Quota Fieldwork Retention

& Back To Surveys Online  Under construction

Quota & Uploa S Download B
L2 Setup Survey

+ Define Variables & ltems B} Order & Nest Variables Define Targets
B sample And Invitations
g . Click the arrow buttons and drag the variables to order and nest quota variables. I Advanced setup
ali Monitor Fieldwark Gender

< Age

Define Targets

Please note: If you are using interlinked quotas, if your resulting quota exceeds three
levels, you should really consider what you are doing. Interlinked quota variables, four
levels deep, means you are using a tremendous number of sample, just to find a very small
number of people.

The result is then this, when you tick “Advanced setup ”:

1 General Questionnaire Quota Fieldwork Retention >
& Back To Surveys Online  Under construction
Quota o i O % ]
£ setup Survey
+/ Define Variables & Items B Order & Nest Variables B} Define Targets
E SampleAnd Invitations Uncheck variables or items to hide them. Hidden variables and items will not show up in the monitoring view. . Advanced setup
ali Monitor Fieldwork
Age
Below 35
Above 35
9
Age
Below 35
Above 35
Define Targets
If you have a quota variable that you would like to use more than once, you can simply
click the Copy button next to that variable at the Order & Nest Variables step with
Advanced setup turned off. This will create a new instance of the quota variable, which
reduces manual effort.
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+" Define Variables & ltems B order & Nest Variables Define Targets

Click the arrow buttons and drag the variables to order and nest quota variables.

Gender ‘
Copy
button
< Age 0
< MainShopper ‘ O ®
< MainShopper > $ Clone variable
MainShopper > => Another Clone
o variable

4.2.4 How to Add Quota Targets

Quota

& Download .~

B Advanced setup

Define Targets

The third and final step is to add targets for each quota variable and item. In this example we will

assume the quotas are interlinked. Enter either only the minimum, only the maximum, or both min

and max targets for each variable and item until you have entered the targets for all your quota

variables.

GENERAL QUESTIONNAIRE QUOTA FIELDWORK

0 Define variables & items 9 Order & Nest variables

Total target: 100

° Define targe

1D Limit overshoot of active interviews

Gender
v Male 40 50
Age
below 35 set minimum 25
35 and above 25 set maximum
v Female 40 50
Age
below 35 set minimum 25

35 and above

25

set maximum

You will normally want to achieve your minimum targets with some oversampling to be safe.

Page 73



Quota

4.2.5 Max Overshoot Option

Online surveys only.

Nfield has a feature called Max Overshoot for Online surveys. With this feature, the system takes into
account not only (successfully) completed interviews, but also the currently active interviews, when it
evaluates whether from a quotas perspective a new respondent is still needed for the survey.

This feature helps against getting large overshoots in quota cells, for instance in the following
scenarios:

e When a survey is started, it is immediately flooded with a large number of respondents,
because the project manager wants quick results. If by chance many of these concurrent
respondents fit in one specific quota cell, that cell easily gets overfilled, especially when the
quota evaluation is done at the start of interview, while the filling of a cell is in Nfield only

incremented at the end of an interview.

e When a survey is nearing the deadline, with some quota cells requiring just one or two more
respondents, and some extra sample gets thrown at the survey. Maybe that sample has been
specifically selected to fill these quota cells. If by chance the respondents all connect at
once, the cells again easily get overfilled.

With max overshoot enabled, the manager elects to take into account active interviews as well as
completed interviews. For example, if a quota cell requires two more respondents and max overshoot
is configured at 2, then at most 4 concurrent interviews can be active on that cell (2 respondents
needed + 2 max overshoot respondents), meaning overshoot for that quota cell will be limited to two
at most. All the other respondents starting an interview for that quota (even before the above 4
respondents are done) will be stratted out.

To enable Max Overshoot, please set the toggle Limit overshoot of active interviews to On, and enter
the number for the maximum overshoot allowed:
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MS. D. EMO
GENERAL QUESTIONNAIRE QUOTA FIELDWORK B & N = DEMO
& Back to surveys Q
£x  Setup survey SLEE v
= s Define variables & items Order & Nest variables Define targets
E Sample and Invitations o e ° ! ° 9
il Monitor fieldwork Total target: 20 @ Limit overshoot of active interviews
Max overshoot: 2
M Reports
AgeGroup
v 18- set minimum 4
Gender
Male set minimum 2
Female set minimum 2
- 10 an v
Notes:

e Max over shoot works only on an explicit maximum target. So if you only fil in minimum
targets the overshoot will have no effect.

e Max over shoots only works on the lowest target of the quota tree. So only on the lowest
child cells. Not on parent cells.

e The overshoot is max overshoot per cell, not a max overshoot on the entire quota frame.

4.2.6 Changing Quota Frames

Once your survey is published you are can always change your targets (both total and level
targets). You can also change your quota frame (add/remove/update levels and quota
variables).

You can to discard any quota frame changes that have not yet been published, if, for
example, you edit a quota frame but later decide not to keep the changes, or accidentally
upload a quota frame meant for a different survey into a running survey by clicking on the
Discard Unpublished Quota Frame Changes button that appears after you saved your
quota frame changes:
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= General Questionnaire Quota Fieldwork Retention e B & a4 & '

& Back ToSurveys Online  Started

+ Define Variables & ltems + Order & Nest Variables + Defina Targets

A\ Requires publist

@ Limit overshoot of active interviews: Max overshoat: 1

Minimum  Maximum

Quota overview target target

Total target: 10
Male2

Below 35
Above 35

Female2

When changing the quota frame, there will be a new quota frame created, but the old one will still be
there. It will just no longer be active. Each of the quota frames (the old one(s) and the active one) will
have their own achievements stored, and its own targets.

There can be only 1 quota frame active: the latest published one.

You can look at all the quota frames with their corresponding achievements in Nfield Monitor
Fieldwork/Quota tab (using the pull-down to select the version of the quota frame). In paradata you
can see to which quota frame a specific interview belongs, since quota frame's ETAG is shown for
each interview.

Please note:

e When changing quota frames you will need to adjust the targets accordingly to what was
already achieved in the previous frame, and what still needs to be achieved. So, when new
quota is published, the targets should be recalculated taking into account the achievements
for the old quota frame(s). For example, if in the old frame the target for a cell was 10, with 6
successful interviews so far. Then the quota frame was updated, we need to make sure that
the target for this cell is 4 (if we still want 10 total for that cell).

e Total Target belongs to each quota frame version (not to all of them), so each time you
update the quota frame, please adjust the Total Target accordingly.

e New ETAG (an unique, random GUID number, found in paradata) for a survey is generated
each time you do a Publish. Let's look at an example:

1. When you first create a quota frame, and publish it, an ETAG will be generated (let's call
it ETAG1).

2. If you make a change the quota frame, and re-publish, an ETAG2 will be generated.

3. If you then make a change to other aspect of the survey (such as a script, etc.), but not
the quota frame, and publish, an ETAG3 will be generated. But in the Monitor
Fieldwork/Quota, Select Version you will only see quotas with ETAG1 and ETAG2. So if you
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wanted to see all the interviews with quota with ETAG2, need to see all the interviews
with ETAG2 and ETAG3.
e Changing quota frame during fieldwork is not desirable. Mistakes happen, so we do allow it,
but it's a bad practice.

427 Uploading and Downloading Quota Frames

If you are setting up a survey and have a similar quota frame set up already in another survey, you
can simply download it from there and then upload it into your current survey. This is especially
helpful when you are working with large or complex quota frames, because it means you do not have

to create them from scratch manually, saving you a lot of time and effort.

You can upload and download Quota frames directly in Nfield Manager in Setup Survey / Quota tab:

General Questionnaire Quota Fieldwork Retention
Quota & Upload & Download
~ Define Variables & ltems v/ Order & Nest Variables ~/ Define Targets

428 Quota in ODIN Script

The actual quota checks take place inside the ODIN script, using the * STRAT command.
The respondents are usually checked early in the script to see if they fit the particular quota
levels.

429 Quota Out in Paradata

When an interview is rejected because the quota has been fulfilled, it is reflected in the
paradata. There could be multiple reasons why an interview can be rejected. The paradata
will only list the first reason found. For more information, please see section Paradata for

the Quota Out.

43  Minimum and Maximum Targets

Minimum and maximum level targets are needed to limit the number of interviews for a quota
level(s). For a quota level you can set:
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e only minimum targets,
e only maximum targets,
e both minimum and maximum targets.

Here are several examples of how to add target limitations:
4.3.1 Only a Total Target Entered

If a quota frame has only the total target entered (for example, 10), it means that after 10 interviews,
all the following interviews will not be allowed (will *STRAT-out).

4.3.2 Total Target and Max Targets for Levels are Entered

Let us say we have a quota frame with the total target entered (16), and for all the quota levels only

the maximum values are entered (4):

= GENERAL QUESTIONNAIRE QUOTA FIELDWORK
& Back to surveys ®
Setup survey Quata B
B Sample and Invitations e Define variables & tems 9 Order & Nest variables e Define targets
A1 Monitor fieldwork Total target: 16
M Reports Brand
Brand 1 4
Brand 2 4
Brand 3 4
Brand 4 4

In this case, the interviewing will stop (* STRAT-out) for each level when 4 interviews are reached for

that level, which will get us the total of 16 interviews.

433 If the Total Target is Not the Same as the Sum of Maxes

Let’s say we have a quota frame as below:
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— GENERAL ‘QUESTIONNAIRE QUOTA FIELDWORK
& Backto surveys 4]
X Setup survey AEE a
B Sample and Invitations @ oefine variables & items @ order & Nest variables @ Dbefine targets
i Monitor fieldwork Total target: 12
M Reports Brand

Brand 1 ot . 4

Brand 2 ot . 4

Brand 3 at - 4

Brand 4 ot - 4

Here, the total target is not equal to the sum of maximum targets of levels. In this situation, the
interviewing for each quota level will stop when the 4 interviews for that level are reached. But the
interviewing for other levels can continue till the total of 12 interviews is reached or that level's total
of 4 is reached. One or more levels in this frame will not reach their maximum target, since the total
target will be reached before that. One of the levels might be left empty (if the other 3 all reach 4
first).

4.3.4 Total Target and Minimum Level Targets are Entered
= GENERAL 'QUESTIONNAIRE QUOTA FIELDWORK
& Back to surveys Q
¢  Setup survey L o
o Define variables & items Q Order & Nest variables ° Define targets

B Sample and Invitations

i Monitor fieldwork Total target: 16

M Reports Brand
Brand 1 4 st maxir
Brand 2 4 et maximum
Brand 3 4 et maximum
Brand 4 4 ot maxir

If only the minimum targets would be entered, and no total target, the interviewing can
continue indefinitely. For every level at least 4 interviews are needed, but the maximum
number per level is not set. So that is why a total target needs to be set here to limit the
number of interviews. If the total is 16, then only 4 interviews for each of the 4 levels will
be done.
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. .
4.3.5 Total Target Smaller than the Sum of Level Minimums
= GENERAL ‘QUESTIONNAIRE QUOTA FIELDWORK
& Backto surveys (4]
£ Setup survey 2siE a
E Sample and Invitations ° Define variables & items 0 Order & Nest variables 0 Define targets
i Monitor fieldwork L N
o Your minimum targets (totaling 16) exceed your overall target (15). UPDATE

M Reports
Total target: 15

Brand
Brand 1 4 et ma
Brand 2 4 et m
Brand 3 4 et maximur
Brand 4 4 etma

If you try to enter the total (15) that is smaller than the sum of the levels’ minimums (16),
you will not be able to save the frame, until corrected.

o o
4.3.6 Total Target Greater than the Sum of Level Minimums
= GENERAL QUESTIONNAIRE QUOTA FIELDWORK
& Backto surveys Q@
¢ Setup survey L 2
B Sample and Invitations Q Define variables & items ° Order & Nest variables o Define targets
i Monitor fieldwork Total target: 20
M Reporis Brand
Brand 1 4 set maxin
Brand 2 4 set maxin
Brand 3 4 set maximur
Brand 4 4 et

If the total target is greater than the sum of the level minimums, then (in the example of the
frame above), we will get at least 4 interviews in every level, and in one or more levels we
will have more interviews than 4, till the total will become 20. For example, might have
the following results:
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Brand 1: 6 interviews
Brand 2: 4 Interviews
Brand 3: 6 interviews
Brand 4: 4 interviews
Total: 20 interviews
4.3.7 Combining Maximum and Minimum Level Targets

If we want to limit the number of interviews in a single level, but still make sure that a certain

minimum is reached for that level, we need both minimum and maximum values filled:

= GENERAL QUESTIONNAIRE QUOTA FIELDWORK
& Back to surveys ®
¢ Setup survey =D g
B Sample and Invitations e pefine variables & items 9 Order & Nest variables 0 Define targets
1 Monitor fieldwork Total target: 30
M Reporis Brand

Brand 1 5 10

Brand 2 5 10

Brand 3 5 10

Brand 4 5 10

In the case above every level will have at least 5, but no more than 10 interviews. The total will be 30,
so the results might look something like this:

Brand 1: 5 interviews
Brand 2: 10 Interviews
Brand 3: 9 interviews
Brand 4: 6 interviews
Total: 30 interviews

If we did not have minimum values here, one of the brands might have not gotten any interviews at
all:

Brand 1: 10 interviews
Brand 2: 0 Interviews
Brand 3: 10 interviews
Brand 4: 10 interviews
Total: 30 interviews
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4.3.8 Overshoot

All the examples above are correct in a “perfect” world. Unfortunately, in the real world an overshoot
of interviews can happen: more interviews done on a level than the maximum set for this level. So,
for example, the maximum for the level might be 10, but the actual number of interviews that got
done on this level is 12. The overshoot can happen if multiple respondents are doing an interview on
that level at the same time, while the level was close to its maximum value. This can happen in large
online surveys.

Let us look at what consequences the overshoot will have for the 6 cases above:

1. Only a total target is entered: you will end up with a few extra interviews than the total
target. So, if the total target was 10, in case 3 respondents started an interview on the 10™
target at close to the same time (before the first one to start is finished), you will end up with
the total of 12 interviews.

2. Total target and max targets for levels are entered: can end up with one or more of the
levels overshot by a few interviews, and the total will be correspondingly overshot:

Max Actual
Brand 1: 4 5
Brand 2: 4 4
Brand 3: 4 4
Brand 4. 4 4
Total: 16 17

3. Ifthe Total Target is Not the Same as the Sum of Maxes: similar to the previous case, can end
up with one or more levels overshoot by a few interviews, and the total will correspondingly
be overshot:

Max Actual
Brand 1: 4 5
Brand 2: 4 3
Brand 3: 4 3
Brand 4: 4 3
Total: 12 14

4. Total target and min targets for levels are entered: since every level has a minimum of 4 (in
our example), and the total maximum is 16, we normally would just have 4 interviews for
each level. If one or more of the levels overshoot the 4, the others will still be allowed to fill
to the minimum of 4 interviews. Please note that the minimums are always stronger than the
maximum: if we have a minimum number of interviews to fill for a level, it will always be
allowed, even if the total (which is a maximum number) has to overshoot.

Min Actual
Brand 1: 4 5
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Brand 2: 4 4
Brand 3: 4 5
Brand 4: 4 4
Total (Max): 16 18

Total target greater than the sum of level minimums: similarly to the case 4 above, even
when the total is reached, if one of the levels has not yet reached the minimum target, it will
be allowed to do that, even if the total has to overshoot:

Min Actual
Brand 1: 4 6
Brand 2: 4 4
Brand 3: 4 7
Brand 4. 4 4
Total (Max): 20 21

Combining maximum and minimum level targets: the levels will end up at least at the
minimum and normally, less or equal than the maximum number of interviews, but it can
happen that one of more levels overshoots the maximum. The total in that case might also
end up overshot if it is necessary to get to the minimum for some remaining level:

Min Max Actual
Brand 1: 5 10 5
Brand 2: 5 10 11
Brand 3: 5 10 10
Brand 4: 5 10 5
Total (Max): 30 31

Least-filled Quota

A script should be able to select a path throughout a questionnaire based on the least-filled quota

levels, or offer selections based on a list ordered by least-filled quota levels. For example, if a

respondent has experience with more than one brand, we can decide to ask questions about one or

more of the brands whose quota levels are least filled so that these quota levels are prioritized when

trying to fulfill quota.

*GETLFQLIST <Nrlevels><LevelName><QuotaVar>

Nrlevels isthe count of quota levels that are still open (numeric variable).
LevelName isan array with the quota levels sorted from least filled to most filled.
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e QuotaVAr isthe quota variable name -- the name of the *SAMPLEDATA variable as defined

in the questionnaire. This may either be a single value sample data variable or an array. The

sample table column must be associated with a quota variable.

Note: Command *GETLFQLIST is only supported in ODIN Developer 5.18 and above.

Usage Notes

e *CONTROL <ArrayVariable> <W|N>ona *QUESTION supports using an array of texts.

The text(s) in the array are matched against the category texts in the question, and the

related codes are displayed or hidden.

e *SAVE <ArrayVariable>ona *QUESTION will take the selected categories of a question

and save their labels in the indicated variable (clearing the existing contents of the variable)

in the order of answers, up to a maximum as defined by the size of the array.

e *ORDER <ArrayVariable>ona *QUESTION displays the categories in the order in which

they are in the array, by label.

e TheArrayvariable inthese commands can either be a *TEXTVARS array or a
*SAMPLEDATA (text) array. Matching is done case-insensitive.

e Nrlevels - Ifyou have 6 levels, and 4 of them are not yet filled, Nrlevels will return

number & (referring to the first 4 levels returned in the array variable).

Important: *CONTROL and *ORDER match array texts against the category labels of the Default

language. Likewise, *SAVE stores category labels coming from the category list in the Default

language. It is important that scripter and researcher ensure that category texts and sample table

contents match.

Example 1: Least Filled Sorting

The script below returns models sorted to relative filling order (least filled first).

**Least filled command script
*TEMPLATE NfieldChicago

**Setup vars for least filled
*SAMPLEDATA model nr
*TEXTVARS ModelLevel[4]
*VARS NrOfNotFilledModelLevels

*GETLFQLIST NrOfNotFilledModelLevels ModelLevel model nr
**Show the result of the least filled command
**Least filled are sorted on relative fillings based on the minimum quota

*PAGE
LevelsReturned: *? NrOfNotFilledModelLevels
Least filled 1: *?ModelLevel[1]
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Least filled 2: *?ModelLevel[2]
Least filled 3: *?ModelLevel[3]
Least filled 4: *?ModelLevel[4]
*END

The following quota frame needs to be setup up for an Nfield survey to correspond with this script:
1. Create a variable model_nr.
2. Add 4 levels for it (Model1-Model4).
3. Define targets for each level.

Next, we need to:
4, Upload a script that will allow us to choose one of the quota levels. For example, this:
*TEMPLATE NfieldChicago

*SAMPLEDATA model_nr

*QUESTION 1 *CODES 101L1 *SAVE model nr
Please choose a model

1:Modell

2:Model2

3:Model3

4:Model4

*END
5. Publish.

6. Start Fieldwork.
7. Do several interviews selecting different model number.

We can then check in Monitor Fieldwork/Quota how many interviews were already done for each
quota level:

PROGRESS QUOTA INVITATION BATCHES PERFORMANCE

& Back to surveys 9

@ Setupsurvey Quota overview EDITTARGETS  SelectVersion: March 4, 2020 12:04 PM (latest) ~ C

Level Minimum  Maximum  Successful

B Sample and Invitations target target  interviews
Model1 10 2
(i Monitor fieldwork
Model2 20 2
M@ Reports Model3 10 4
Model4 20 7
Total target: 60 15

In the case above, we can see that Model2 is the least filled quota at this time (only 2 successful
interviews out of the minimum target of 20, so only 10% filled); Model3 is the most filled (4 out of 10 -
40% filled).

If we now upload the Least Filled Script (above, under the Example 1), re-publish, and run the live
interview, we will see the levels sorted least to most filled:
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LevelsReturned: 4

Least filled 1: Model2
Least filled 2: Modell
Least filled 3: Model4
Least filled 4: Model3

Example 2: *ORDER Command with Least Filled Quota

Upload the script below to the same survey:

**Least filled command with ordering
*TEMPLATE NfieldChicago

*SAMPLEDATA model nr

*TEXTVARS ModelLevel[4]

*VARS NrOfNotFilledModelLevels

*GETLFQLIST NrOfNotFilledModelLevels ModelLevel model nr

**Show least filled order using the array returned by the *GETLSTQLIST as the argument for an *ORDER command
*QUESTION 10 *CODES 61L1 *ORDER ModelLevel

1:Modell

2:Model2

3:Model3

4:Model4

*END

Publish and run a live interview. We get the same least filled model order as in the previous example,
but now in a question:

Least filled order

Model2
Model1
Model4

Model3
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Example 3: *CONTROL Command with Least Filled Quota

*CONTROL command can now also be based on the *CoDES label instead of only the *CODES
number. To make this work, use a text array (like the one *GETLFLIST returns) as an argument. Also,
you can adjust the array size to only receive the X number of least filled levels. Here is an example
script:

*TEMPLATE NfieldChicago
*SAMPLEDATA model_nr

**Use array size 1 to only receive the first of the least filled quotas
*TEXTVARS ModelLevel[1]
*VARS NrOfNotFilledModelLevels

*GETLFQLIST NrOfNotFilledModelLevels ModelLevel model nr

**Use control to show only the labels returned by the *GETLFQLIST, in this case only one
*QUESTION 10 *CODES 61L1 *CONTROL ModelLevel W

1:Modell

2:Model2

3:Model3

4:Model4

*END

If you upload and run this script in the same survey we've been using earlier, it will only return
Model2, which is the highest one in the least filled quota list:

Least filled order

Maodel2

Example 4: Fill the Sample Data with Least Filled Quota, Store in DAT-File
*TEMPLATE NfieldChicago
**set up the vars for the least filled quotas

*SAMPLEDATA model_nr
*TEXTVARS ModelLevel[4]
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*VARS NrOfNotFilledModelLevels

**Get the least filled quotas for the quota model nr
*GETLFQLIST NrOfNotFilledModelLevels ModelLevel model nr

**Show the order of the least filled, just to check
*QUESTION 10 *CODES 61L1 *ORDER ModelLevel
Least filled order

1:Modell

2:Model2

3:Model3

4:Model4

**Use the most lacking quota for this interview
*PUT model nr [ModelLevel[1]]

** For easy data processing store it also in the Ufile

*QUESTION 11 *CODES 62L1 *DUMMY *VAR ModelUsed
ModelUsed for this interview

1:Modell

2:Model2

3:Model3

4:Model4

** Loop over the models until it matches the nr 1 returned and then store that code in the dummy Q11
*TEXTVARS BrandToCheck

*REPEAT 4

*PUT BrandToCheck Q11, 7R

*IF [BrandToCheck = ModelLevel[1]] *INCLUDE Q11 [?R] *END

*ENDREP

*END

Example 5: Least Filled Quota with Mins and Maxes filled, Single Quota Variable

Let's create the following quota frame (very similar to example 1, but this time with maximum values
also filled):
®

Quota

a Define variables & items ° Order & Nest variables a Define targets

Total target: 18

Color

Blue 3 5
Red 3 5
Green 3 5
Yellow 3 5

Upload a script below, publish, and start fieldwork.

*TEMPLATE NfieldChicago
*SAMPLEDATA color

*QUESTION 1 *CODES 101L1 *SAVE color
Please choose a color

1:Blue
2:Red
3:Green
4:Yellow
Page 88
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*END

Do several interviews selecting different colors. You can then check in the Monitor fieldwork/Quota
how the fieldwork is going. Here we can see that for 2 of the levels the minimum target is met.

Please note:
e A checkmark next to the minimum target and the green color mean that the min target is met
for the level.
e A cross next to max target and an orange color mean that the maximum target for that level

is overshot.

PROGRESS QuoTA INVITATION BATCHES PERFORMANCE

& Backto surveys Q

Quota overview EDIT TARGETS rsion: March 4,2020 3:14 PM (latest) ~ &

% Setup survey

Level Minimum  Maximum  Successful

E Sample and Invitations target target  interviews
Blue v 3 5 5
i Monitor fieldwork Red v3 5 ;
M Reports Green 3 5 1
Yellow 3 5 2
Total target: 18 12

**Least filled command script
*TEMPLATE NfieldChicago

**Setup vars for least filled
*SAMPLEDATA color
*TEXTVARS Colors[4]

*VARS NrOfNotFilledModelLevels

*GETLFQLIST NrOfNotFilledModelLevels Colors color
**Show the result of the least filled command
**Least filled are sorted on relative fillings based on the minimum quota

*PAGE

LevelsReturned: *? NrOfNotFilledModelLevels
Least filled 1: *?ModelLevel[1]

Least filled 2: *?ModelLevel[2]

Least filled 3: *?ModelLevel[3]

Least filled 4: *?ModelLevel[4]

*END

The result is this:
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—

LevelsReturned: 3
Least filled 1: Green
Least filled 2: Yellow
Least filled 3: Red
Least filled 4: Blue

It might seem surprising that the number of not filled levels is 3, since two of the four levels have
their minimum targets already met. The reason is that while least filled quota only looks at the
minimum targets, the NrOfNotFilledModelLevels is based on what the *STRAT command considers
filled or not filled level target. In our example, level Red has not yet reached its maximum target (it is
currently at &4 interviews, while the max target for it is 5), and the Total Target of 18 still allows it to
reach the maximum target (we only have 12 interviews done, and if Red gets another interview, it will
not interfere with Green or Yellow getting to their minimum targets). So, level Red is added to Yellow
and Green in the NrOfNotFilledModelLevels to make it 3.

If the total target in this case was 15, instead of 18, it would not be possible to fill in Green and
Yellow’s minimum targets while still having another interview for the Red, so Red would have been
excluded from the NrOfNotFilledModelLevels, and it would have been 2.

Notes

Please remember that:
e Least filled quota levels are taken over minimum targets.
e Least filled is based on relative fillings.
e List returned is sorted from least filled level to most filled.
o If levels are filled equal, they are returned in the random order.
e Overshot levels are also returned, ordered from least overshot to most overshot.
e Number of Not Filled Levels is based on what the *STRAT command considers filled or not
filled level target.

4.5 Multi Quotas

To turn quota variable to multi-select, please turn the slide Multi on when creating a quota.



GENERAL QUESTIONNAIRE QUOTA FIELDWORK
Quota B
o Define variables & items e de est variable ° Define target
Variable name Questionnaire variable Muit
Brandss brandss ® 10
Level value label
Brand1 [ 1
Level value label
Brand?2 [ 1
Level value label
Brand3 [ ]

ADD VARIABLE

ORDER & NEST VARIABLES

Example 5: Multi Quota with Least Filled

Quota

Ask which brands are known by the respondent. Continue the interview for the 3 least known brands.

*TEMPLATE NfieldChicago

**Brands is a multi-quota so we use an array as sample data, array must be big
enough to hold all the quota levels

*SAMPLEDATA Brands[26]

*TEXTVARS BrandName[26], LeastFilledBrand, SelectedBrand

*VARS NrOfBrands, NrOfSelectedBrands, NrOfKnownBrands

*LIST "Brands"
1:BrandA
2:BrandB
3:BrandC
4:BrandD
5:BrandE
6:BrandF
7:BrandG
8:BrandH
9:BrandI
10:BrandJ
11:BrandK
12:BrandL
13:BrandM
14:BrandN
15:BrandO
16:BrandP
17:BrandQ
18:ModelR
19:ModelS
20:ModelT
21:ModelU
22:ModelV
23:ModelW
24:ModelX
25:ModelY
26:ModelZ

*Get the brands known by the respondent

*QUESTION 10 *CODES 61L26 *MULTI *VAR "KnownBrands" *UIOPTIONS "columns=3"
Which of these brands do you know?

*USELIST "Brands"

**if respondent does not know at least 3 brands screen him/her out
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*COUNT NrOfKnownBrands Q10
*IF [NrOfKnownBrands < 3] *GOTO 9998

*QUESTION 20 *CODES 87L26 *MULTI *VAR "SelectedBrands" *DUMMY
Brands used for interview
*USELIST "Brands"

*GETLFQLIST NrOfBrands BrandName Brands

*PUT NrOfSelectedBrands [0]

**start repeat to loop over all returned brands in order of least to most filled

*REPEAT 26

*PUT LeastFilledBrand [BrandName[?R]]

**start repeat to check known brands against the least filled

*REPEAT 26 *CONTROL Q10 W

*PUT SelectedBrand Q10,?R

**if known brand match least filled then include this a selected brand raise the nr of brand already selected and end the loop for this
known brand

*IF [LeastFilledBrand = SelectedBrand] *INCLUDE Q20 [?R] *PUT NrOfSelectedBrands [NrOfSelectedBrands + 1] *END
*ENDREP

*IF [NrOfSelectedBrands = 3] *END **If 3 brands are selected stop looping

*ENDREP

**Fill the quota variable with the selected brands
*REPEAT 26 *Control Q20 W

*PUT Brands[?R] Q10,?R

*ENDREP

**Show the selected brands on screen

*QUESTION 999 *CODES 139L2 *CONTROL Q20 W
Selected brands

*USELIST "Brands"

*END

*Q9998
This survey is not for you

*ENDNGB

For this script we need to create a new survey with quota frame containing a variable Brands, with
26 levels in it called BrandA-Brandz, and Multi slide turned on. Let's set only minimum targets for
each level to 2.

= GENERAL  QUESTIONNAIRE QUOTA  FIELOWORK > B & O [MNAsises
& Back 1o surveys (2]
£ Setup survey
B sample and Invitatiens @ Dcine variasles & tems @ Order & Nest varables & oefine targets
Wi Monitor fieldwork
A Quota editing has been locked has started. The targets are still editable.
@ Reports
Total target: 52
BrandA 2
Brandd
BrandC
BrandDd
BrandE
BrandF 2
BrandG
BrancH
Erandl
BrandJ
L L] L] L] L] o o L o o L L] L] L] L] L] L] L] L] L] L] L]
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When we run the interview for this survey, we are first presented all the brands, out of which we
select, let’s say, 6 brands: D, I, N, P, T, X. We are then presented the 3 least selected brands (out of
these 6), and since at this point all 6 are least selected, it will randomly select 3 brands from this list:
let's say P, N, D.

If we run this script again, and choose the same 6 brands: D, I, N, P, T, X, we will be presented with I, T,
X (not necessarily in that order), since the other 3 brands were chosen in the previous run.

4.5.1 Linking Multi Quota with Other Quotas

Multi quota variable should be at the end of the branch. If it is placed anywhere else, it is not
possible to interlock it with other quota variables.

In the picture below, Brands, which is a multi-quota variable (identifiable by the plus next to its

name) is linked to a quota variable Gender:

o Sewp a
B vt @ ot s e PP — o
Wi Monitor felawork
» Advanced
@ Rer
DeFINE TARGETS

It is also possible to link all the brands, but only if the multi quota variable, Brands, is the last one in
the chain, as in the picture below:
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GENERAL  QUESTIONNARE  QUOTA  FIELDWORK e B O 0 &wwarws
& Backio surveys ()
£ Setupsurvey £ 8
@  Sample and Invitations @ vetneanabies sitems © over s st aribies o

W Monitor fieldwork

W Advanced setup
@ Reports

Gender

DEFINE TARGETS

If you try to link Brands to, for example, 2ge while Age is below it, you will get an error, and will not

be able to save:

= GENERAL QUESTIONNAIRE QuoTa FIELDWORK e B & O 2wrwarw
& Backto surveys Q

£ Setup survey g o

B sampleand Invitations. @ oeine vansvles aems © orer s vest variables © oeie e

Wi Monitor fieldwork.

B Advanced setup
B Reports [ preview

“This variable cannot be nested because the preceding variable is mulli

DEFINE TARGETS

4.6 Quota frame validation

When a quota frame is defined and target values are filled in, we want to ensure that the configured
quota frame is valid, meaning the given minimum and maximum values in the frame are achievable
by a set of counts that for all levels is higher than the minimum (if configured) and lower than the
maximum (if configured).

In brief, this means that:
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1. for each level, the minimum value (if configured) must be lower than or equal to the
maximum value (if configured)
2. for each level that has nested single-code variables, the sum of the minimum values of the
nested variable categories has to be lower than or equal to the level's maximum value
3. for each level that has nested single-code variables, the sum of the maximum values of the
nested variable categories has to be higher than or equal to the level's minimum value
4, for each level that has nested multi-code variables, the minimum values of the nested
variable categories have to be lower than or equal to the level's maximum value
If for a quota frame one of these conditions is not met for at least one level, that quota frame is not
consistent, and during fieldwork no set of level fillings can be achieved that meets with the quota
criteria. The user should be shown an error in this case and suggestions for improvements should be
shown. For case 1, the respective level should be marked, for cases 2-5, the respective 'parent' level
should be marked.

4.7 Counting Quota Level More than Once per Interview
For some scenarios, you might want to count quota level more than once per interview.
Nfield allows to write the same value to a different index in an array of the *SAMPLEDATA

variable. This value will count as many times as it occurs for quota.

Example script:

*VARS numberoftrips

*SAMPLEDATA MyCountries[10]

*QUESTION 1 *NUMBER 61L2 *MAX 10

How many trips abroad did you make past year?
*PUT numberoftrips Q1
*REPEAT 10 *FIELD 63L70

*VARS iteration

*PUT iteration [?R]

*IF [iteration > numberoftrips] *END



*QUESTION 2 *CODES 1L7 *MULTI *SAVE MyCountries[?R]

Where did you go on trip #*? iteration ?

l:Netherlands
2:Spain
3:Greece
4:France
5:Portugal
6:Poland

7:India

*ENDREP

4,711 See Also
*CONTROIL

116

*GETLFQLIST

145

*ORDER

*STRAT

206
252

Nfield Academy videos 51 through 54

Quota
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5.

5.1

Suspend and Resume Interview

Suspend and Resume Interview

Ways to Suspend an Interview

There are 4 ways in which an interview can fall into the Suspend status:

For the Online interviews, if the respondent does not have any activity on an interview for 15
minutes, the interview will be suspended.

For the Online interviews: if the interviewers chooses the Pause button.

For the CAPI interview, if the interviewer presses the device’s Back button, and chooses the
“Save and Suspend” option.

For both channels, if the script ends the interview with a response code that allows a
suspend (standard system code 29).

For CAPI interviews, you can also schedule appointments via script. To do that you need to first
upload the list of custom response codes you want to use in the Nfield Manager making sure to
check the option ‘Appointment’ for each of these codes. You are now able to use the *ENDST
command to get to the appointment dialog during the interview, so that an interviewer can
create an appointment with the respondent.

GENERAL QUESTIONNAIRE QUOTA FIELDWORK > E a I‘\ * mgzw“

€ Backto surveys T O & DOw d

£ Setupsurvey Response

Code  DESCTiption Definite Selectable Appointment

B sample and Assignments

Wi Monitor fieldwork

Notes:

My response code L

All suspended interviews are counted as drop-outs in the Nfield Manager/Monitor screen.
As soon as an interview is suspended, it is no longer an active interview. So it will no longer
be counted for quota if you have turned on “Limit Overshoot of Active Interviews” (see
chapter 4, Quota).
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5.2 Resume Interview

For CAPI, the only types of surveys for which the interviews can be resumed are CAPI with Addresses.
For Online, you can only resume interviews if you use response keys.

When the interview is resumed, it is restored in the exact same state as it was when it was paused.
The system does it by re-running the interview, and filling it with the answers given in the previous
session. There is one exception: the *STRAT command is always run and checked against the current
quota. So, if the quota has been filled in the meantime, the resumed interview will be sent to quota
full state.

So quota will be handled as is. Everything else will run as it was. That means that an interview date
that was stored (using the *DATE command) in the previous run of the interview (the date of the 1%
run), will still be the date that is stored in the resumed interview. You can modify this behavior using
the *INIT command.

Also, any variables that you pass in the URL are always processed as was resuming, and not as is. For
example, if you are starting an interview with a parameter gender=Male, and you are resuming the
interview with gender=Female, the value of gender will still be Male for the resumed interview. This
might be unwanted, especially if you are stepping out of an interview to run a 3" party application. In
that case, you would probably want the information gathered to be passed back to the Nfield
interview. This is possible by using a special result code 107. So normally you would pause an
interview with code *ENDST 29 hand it over to the 3™ party application, but if you to read the
(updated) parameters, you would pause with code *ENDST 107.

Order in which script items are executed when resuming:

e If you have an *INIT block, normally, it will be executed first when you run an interview. If you
pause, and then resume an interview, the *INIT block will be executed after the script has
resumed until the point where it needs input from the respondent, but before the page is
rendered.

e If you use a result code 107, the URL variables will be re-read before the *INIT block is run.

Notes:

e Be aware that if you resume on a different version of the script, it could impact where the
interview is resumed. So, if for example, if a question was added before the question on
which the interview was stopped, it will on resume go to the new question. The same will
happen if the routing was changed - on resume, the new route will be used.

e Ifyou use code 107, the interview will still be counted in the quota. If you resume this
interview, it will not be checked against quota again.



Command Index

6. Command Index

This section contains an alphabetically sorted list of NIPO ODIN script commands.

6.1 *?
Purpose

Retrieves the contents of a variable or array as text.

Syntax

*? <var | var[n|expression] | QquestionNumber | QquestionId>

Description

The contents of a variable or array are retrieved and put in place of the command and will be
processed as text. This command may occur at any place where text may occur.
In addition to referencing variables, *? supports references to question number and question ID.

Arguments

var

This is the name of the variable from which the contents are retrieved.

var [n|expression]

When an array-variable is used, this the name of a variable followed by (between square brackets) a

positive integer or expression that indicates the element-number of this array.
QquestionNumber/ QquestionId

Pipes the answer to the named question. In case of a multi-coded question, it pipes in the label of
the lowest mentioned code.

Remarks

e You can use uppercase and lowercase names indifferently; variable names are case insensitive.
e System variables may be displayed, but do not need to be defined using *VARS or *TEXTVARS.

Example 1
*TEMPLATE NfieldChicago
*TEXTVARS Gender,Age

*QUESTION 1 *CODES L1 *SAVE Gender
Int. type gender of respondent

1: Male
2: Female

*QUESTION 2 *NUMBER L2 *SAVE Age
How old are you?

*PAGE
So you are a *?Gender of *?Age years old.



Command Index

Result of Example 1

So you are a Male of 36 years old

NEXT

Example 2
*TEMPLATE NfieldChicago

*TEXTVARS txt[4]

*PUT txt[1] "This is a text."

*PUT txt[2] "Another text."

*PUT txt[3] "Third text."

*PUT txt[4] "The fourth line contains: "*?txt[ 1] *?txt[2] *?txt[3]"

*PAGE
9 txt[1]
9 txt[2]
9 txt[ 1] *2 txt[2] *? txt[3]
9 txt[4]
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Result of Example 2

This is a text.

Another text.

This is a text. Another text. Third text.

The fourth line contains: 'This is a text. Another text. Third text.

Example 3
*TEMPLATE NfieldChicago

*TEXTVARS Number, Price, PricePerFax, PricePerFaxFormatted
*FONT 0 "10 Arial"

*QUESTION 1 *FORM
Specify count and price:

1:Number of fax machines bought: *NUMBER 61L3 *SAVE Number
2:Total price paid: € *NUMBER 64L4.2 *SAVE Price

*PUT PricePerFax [Q1F2/QI1F1]
**format PricePerFax to 2 spaces after the dot (cents).

*PUT PricePerFaxFormatted [?STRSUBSTR(PricePerFax,1,?STRINDEX(PricePerFax,".")+2)]

*QUESTION 2 *CODES 70L1
You bought *? Number fax machines for € *? Price?

So the average price per fax machine was € *? PricePerFax ?

1: Yes
2: No

Page 101



Result of Example 3

—

You bought 3 fax machines for € 425.507

So the average price per fax machine was € 141.83 7

Using a variable (*?) to reference ids

In expressions it's possible to use a variable instead of a direct id reference. For example:

*PUT result [Ql, {*?id variable}]

Command Index

where id_variable is a variable containing the value of the id. In this case, if a category with the id

of the value of id_variable is not found then the expression will evaluate to 0, the same as if the

category with the id existed but was not answered.

Example 1

*QUESTION 1 *NUMBER 61L1 *ID "Numberld"
How many fruits do you eat daily?
*QUESTION 2 *OPEN 62L10 *ID "Fruitld"

What fruit you eat *?Q1 times daily?, in roughly 67% of the cases the interview jumps to question 100.

Referencing question number using *?.

Example 2

*QUESTION | *NUMBER 61L1 *ID "Numberld"
How many fruits do you eat daily?

*QUESTION 2 *OPEN 62L10 *ID "Fruitld"
What fruit you eat *?Q{Numberld} times daily?

Referencing question id using *2.
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6.1.1.1  See Also

*ID 160
*PUT 217
*SAMPLEDATA 246
*SAVE (codes option) 249
*SAVE (question option) .....cceeeeveeeevnnes 247
*TEXTVARS 268
*VARS 286

Command Index
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6.2 *ALPHA

Purpose

Defines a text question.

Syntax

*ALPHA [pos]L<length>|<pos>

Description

This command is always used in combination with *QUESTTION and must be specified after
*QUESTION on the same line. Defines a question that expects an alphanumerical answer. Contrary to
an *OPEN question the length of an answer to an *ALPHA question is limited and the answer is
stored in the DAT-file.

*ALPHA can be also used to define a text filed in * FORM questions.
Arguments

Pos

This is the start of the data field where the data is written in the DAT-file.
length

This is the length of the data field.

Example 1
*TEMPLATE NfieldChicago

*QUESTION 1 *ALPHA 61L20
What is your first name?

Result:

What is your first name?
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Example 2 (in *FORM)
*TEMPLATE NfieldChicago

*QUESTION 1 *FORM *BUT 99 "Refusal"
Please, fill in your name and address:

1:Name : *ALPHA 73L30
2:Street: *ALPHA 103140

3:Place : *ALPHA 143120
Result:

Please, fill in your name and address:

Name :
Street:

Place :

Refusal

6.2.1.1  See Also

*CODES 114
*LIST (definition) 176
*NUMBER 201
*OPEN (Question type) .......eeeevereerennes 203
*QUESTION 220
*FORM 141
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6.3 *BACK

Purpose

Jumps back to a previous question.
Syntax
*BACK <n| [expression]>

Description

The interview will return to the question specified in the argument. It does in fact the same as
pressing the Back button as many times in succession as needed to reach that question.

When the *BACK command is executed, all commands and answers between the current question

and the question you are returning to are undone in the data (they are still visible on the screen as
they are still in memory cache, but unless re-submitted, they will not be saved into the data file), as if
you actually stepped back through the questionnaire. This is major difference with the command
*GOTO.

Arguments

n|lexpression

This is a positive integer or expression that indicates an existing question.
Remarks

With *BACK you can only jump back to a question that was previously displayed according to the
current routing. If the indicated question was never displayed, the *BACK command is ignored.
Example

*VARS tot

*VARS answer[3]

*QUESTION 1 *FORM

What proportion of travels are done by ....

(Int. don’t know = 999”)

1:Bus *NUMBER L3 *RANGE [ 0 TO 100;999 ] *SAVE ANSWER[1]
2:Train *NUMBER L3 *RANGE [ 0 TO 100;999 ] *SAVE ANSWER[2]
3:Car *NUMBER L3 *RANGE [ 0 TO 100;999 ] *SAVE ANSWER([3]

** If one of the values is a Don't Know, skip the check
*IF [ Q1F1 =999 \Q1F2 =999\ Q1F3 =999 ] *GOTO 3

*PUT tot [ QIF1 + Q1F2 + QIF3 ]
#IF [ tot > 95 & tot < 105] *GOTO 3

*QUESTION 2 *CODES L1
Your percentages must add up to 100%!

*? answer[1]

*? answer[2]
*? answer[3]

1: Go back and try again *BACK 1
*QUESTION 3
In this example, we jump back to the first question to correct the percentages if they are not in the

range 95 to 105.
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6.3.1.1 See Also

*GOTO 153
*STRAT 252
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6.4 *BLOCK

Purpose

You can show multiple questions on one page, with optional conditions with the *BLOCK command.
This is a useful feature for displaying related questions, or to speed up interviewing, displaying more
information on fewer screens. In the Example 1 below, the 2nd question will be shown on the same
page, next to the 1st question, only if the answer to the 1st question is "1", otherwise it does not get
shown. If we remove the condition, both questions will be displayed on the same page.

*BLOCK opens what you wish to display on the page. The page ends with *ENDBLOCK.

Syntax

*BLOCK
Questions, arguments, scriptcode
*ENDBLOCK

Description

Creates multiple questions on the same page.

Remarks

All forms of routing are supported in *BLOCK. Unlike in *FORM command, you can use *CODES on
questions in *BLOCK. You can also create *IF and use *CONTROL statements in *BLOCK referring
to other questions inside that *BLOCK.

Note: It is not allowed to use *BUT, *MATRIX, *REPEAT, *SAVE, *PUT or *COPY commands in
*BLOCK.

Example 1
*TEMPLATE NfieldChicago

*BLOCK
*QUESTION 1 *CODES 61L1
Q1 What car do you drive?

1: BMW
2: Audi
3: Volkswagen

*QUESTION 2 *CODES 62L1 *IF [Q1, 1]
Q2 Do you drive it often?

1: Yes
2: No
*ENDBLOCK
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Q1 What car do you drive?

Audi

Volkswagen

Q2 Do you drive it often?

Yes

Example 2

*TEMPLATE NfieldChicago

*BLOCK
*QUESTION 1 *CODES 61L1
What is your gender?

1: Male
2: Female
9: Do not wish to answer

*QUESTION 2 *CODES 70L9 *MULTI *IF [Q1, 1,2]
Have you ever used the following shaving products?

1: Gilette Razors

2: Palmolive Shaving Cream
3: Gilette Aftershave

9: None of these *NMUL

*ENDBLOCK

We begin by asking about the respondent's gender. An additional question appears on the page if the
respondent has provided his/her gender, asking if they have ever used the specific shaving products.
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What is your gender?

Female

Do not wish to answer

Have you ever used the following shaving products?

Gilette Razors
Palmolive Shaving Cream

Gilette Aftershave

6.4.1.1 See Also

*MATRIX 182
*FORM 141
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6.5 *BUT

Purpose

Defines a button.

Syntax

*BUT <code> <"text">

Description

With this command you create user-defined buttons which are displayed during the interview. These
buttons can be used instead of or next to answer categories. If you click on the button the relating
code is written.

Arguments

code

This is the code that is stored when pressing the button.

text

This is the button text.
Remarks

e A maximum of five buttons per question is allowed.

e When using buttons on a *FORM question the value of the buttons is stored in the first field of
the form question.

e Allowed in *LANGUAGE section.

e Buttons are not supported on matrixes and blocks.

Example
*TEMPLATE NfieldChicago

*QUESTION 1 *CODES 61 *BUT 5 "Don't know"
How often do you read a newspaper?

1: Daily

2: Once a week
3: Once a month
4: Never

In this example, the category for ‘Don’t know’ is left out of the category list. Instead a button is
defined to enter this answer:
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Result:
How often do you read a newspaper?
Daily
Once a week
Once a month
Never
Don't know
Example 2

*TEMPLATE NfieldChicago

*QUESTION 1 *FORM *BUT 99 "Refusal"
Please, fill in your name and address:

1:Name : *ALPHA 73L30
2:Street: *ALPHA 103140

3:Place : *ALPHA 143120

Result:

Pleaseg, fill in your name and address:

Name :
Street:

Place :

Refusal

If the Refusal button is used, the code 99 is stored in the first field (Name).
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6.5.1.1 See Also
*USEBUTTONS 277
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6.6 *CODES

Purpose

Defines a question type.
Syntax

*CODES [pos]L<length>|<pos>

Description

This command is always used in combination with *QUESTION and must be specified after this
command on the same line. It defines a closed question with a set of precoded answer categories,
where each category has a unique value.

Arguments

Pos
This is the start of the data field where the data is written in the DAT-file.

length

This is the length of the data field.

In a closed, but not multiple question the number of digits of the highest category number defines
the minimum length of the data field. In a closed, multiple question the highest category number (i.e.
not the number of categories) defines the minimum length of the data field.

Remarks

e Itisalso possible to define a dummy question by omitting the categories in order to store data
from other questions or variables or to use it as a label.

e The NIPO ODIN Developer reports a warning message when the length is more than the highest
code number requires. The NIPO ODIN Developer reports an error message when a *CODES
question without *MULTI exceeds the maximum size of L10 (max. code number is 2147483647 =
232-1),

Example 1

*QUESTION 1 *CODES 61

Do you own a car?

1: Yes
2: No

In this example, a closed question is defined with two pre-coded answer categories.

Example 2

*QUESTION 2 *CODES 62L25 *MULTI
What brands of cars do you know?

3: Citroén
4: Fiat

5: Ford

6: Hyundai
7: Mazda
8: Mitsubishi
9: Nissan
10: Opel
11: Peugeot
12: Renault
13: Suzuki

Page 114



Command Index

14: Toyota
15: Volkswagen
16: Volvo

24: Other *NOCON *OPEN
25: Don't know

In this example a closed question with multiple answers is defined. Because the highest code-
number is 25, the field has to be at least 25 positions long. When the interviewer or respondent is
using the keyboard to type the code-numbers, the various codes should be separated by a space,
that is generated automatically when a code number is ‘complete’. So, it is best to skip code 1 when
using code 10 and higher, skip code 2 when using code 20 and higher.

6.6.1.1 See Also

*ALPHA 104
*FORM 141
*MULTI 195
*NUMBER 201
*OPEN (QUestion type) ......eeeeereeeerennes 203
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6.7 *CONTROL

Purpose

Makes the display of answer codes and labels dependent on answers to a previous question.
Syntax

*CONTROL <Qn|ArrayVariable> <W|N>

Description

This command is always used in combination with *QUESTION, *FORM or *REPEAT and has to be

specified after these commands on the same line. This command controls the display of answer

codes and texts depending on answers to a previous question. This so-called ‘controlling’ question is

referred to by means of On.

e When used in combination with *REPEAT, execution of repetition numbers only takes place (or
not) if the numbers correspond with the answer codes mentioned in the controlling question.

e Ona *QUESTION, it supports using an array of texts. The text(s) and numbers in the array are
matched against the category texts in the question (in default language), and the related codes
are displayed or hidden.

Arguments

On

The reference to the control question where n is the number of the question.
ArrayVariable

An array of texts.

W

Only answer categories that were mentioned at the control question are being displayed.
N

Only answer categories that were not mentioned at the control question are being displayed.

Remarks

e Make sure that the control question and the current question have the same set of answer
categories. Categories that are suppressed as a result of this command, can't be part of the
answer. When all categories are suppressed the question will be skipped.

e wWand N are optional because you can also use the *CONTROL command to export the correct
variable names of a question in a *REPEAT.

Example 1

*QUESTION 1 *CODES 61L5 *MULTI
What PC makes do you know?

1: Acer

2:IBM

3: Tulip

4: Other *OPEN

5: Don’t know *NMUL
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*QUESTION 2 *CODES 66L5 *MULTI *CONTROL Q1 N

Which of the following PC makes do you know?

1: Acer

2: IBM

3: Tulip

5: None of these *NMUL *NOCON

In this example, the answers mentioned in question 1 are not displayed in question 2. However, if
Don’t know is selected in question 1, this category is still displayed in question 2, because it is
excluded from the control option by *NOCON.

Example 2

*CONTROL command can also be based on the *CODES label instead of only the *CODES number. To
make this work, use a text array (like the one *GETLQFLIST returns) as an argument. Also, you can
adjust the array size to only receive the X number of least filled levels. Here is an example script:

*TEMPLATE NfieldChicago

*SAMPLEDATA ModelNr

**Use array size 1 to only receive the first of the least filled quotas
*TEXTVARS ModelLevel[1]

*VARS NrOfReturnedModelLevels

*GETLFQLIST NrOfReturnedModelLevels ModelLevel ModelNr
**Use control to show only the labels returned by the GETLFQLIST, in this case only one
*QUESTION 10 *CODES 61L1 *CONTROL ModelLevel W
1:Modell

2:Model2

3:Model3

4:Model4

*END

This script will return the highest level in the least filled quota list.

6.7.1.1 SeeAlso

Least Filled Quota 83
*FORM 141
*GETLFQLIST 145
*NOCON 198
*QUESTION 220
*REPEAT ... *ENDREP 230
Page 117



Command Index

6.8 *COPY

Purpose

Transfers data within a questionnaire.
Syntax
*COPY <Qn> <Qm| [expression] |"text">

Description

This command is also allowed under condition. Data specified in the second argument will be
transferred to the question specified in the first argument. *Copy is interpreting the contents of
questions to be moved. The original contents of the receiving question, if any, will be replaced.

Arguments

Oon

The question reference of the question where the data will be transferred to (i.e. the receiving field).
Qom

The question reference of the question that will be transferred (i.e. the sending field).
expression

If an expression is given as second argument the result of the expression will be a value. This value
will then be put as data in the receiving question.

text

This text will be transferred literally to the receiving question. It is allowed to refer to a variable in
the text. In that case, the contents of this variable will be embedded in the text and then will be
transferred to the receiving question.

Remarks

e Itis recommended to use the same question type for both sending and receiving fields.

e If the data that has to be transferred consists only of digits, NIPO ODIN regards this as a number.
Therefore, to transfer data from a multiple question you have to use * INCLUDE.

e When using the *INCLUDE command to include codes in a single-coded question, the contents
will be set to the highest code. Use the *copPYy command to overwrite original contents.

e Contrary to the *INCLUDE command the *copY command will give warning messages when data
positions are used more than once. Use the *INCLUDE command to suppress these warnings.

e When a question already contains the category that was copied, nothing changes.

Example 1

*QUESTION 1 *CODES 71L2
*COPY QI [3]

The contents of Q1 will be 03.
Example 2

*QUESTION 1 *CODES 71L2
*QUESTION 2 *CODES 81
*COPY Q1 Q2

The contents of Q2 are stored in Q1. For example, if Q2 contains 8, the contents of Q1 will be 08.
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6.8.1.1 See Also

*EXCLUDE 132
*INCLUDE 165
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6.9 *COUNT

Purpose

Counts the number of answers.
Syntax

*COUNT <Qn|numvar> <Qm>

Description

This command is also allowed under condition. The number of answers to the question specified in
the second argument is counted and will be put as a number in the data field or variable specified in
the first argument.

Arguments

Oon

The question reference of the data field where the number is stored.

numvar

The name of the numeric variable where the number is stored. This variable has to be defined earlier
in the questionnaire.

Qm

The question reference from which the number of answers have to be counted.

Remarks

This command is only useful for multiple codes (*MULTI) questions.
Example
*QUESTION 1 *CODES 178L7 *MULTI

What brands of beer do you know?

1: Heineken

2: Amstel

3: Grolsch

4: Carlsberg

5: Tuborg

6: Other *OPEN

7: Don’t know *NMUL

*VARS numb

*COUNT numb Q1

*QUESTION 2 *CODES 185 *IF [Q1,1-6]
So you know *? numb brands of beer?

1: Yes

2: No

In this example, the number of answers on question 1is counted in the variable numb and used in
the question text of question 2.

Note: With *COUNT none of the arguments can have a variable.
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6.9.1.1 See Also

*ID 160
*MULTI 195
*VARS 286
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6.10 *DATE

System

Nfield CAPI and Nfield Manager.

Purpose

Retrieve the current date and time to be stored in a variable or (dummy) question.
Syntax

*DATE <Qn|var|array>

Description

This command is also allowed under condition. This command stores a date / time stamp in a
(dummy) question or a variable. In Nfield CAPI for Android, the local time of the interviewer mobile
device is stored. In a web preview, the UTC date and time of the interview are stored.

Arguments

<Qn>

A (usually dummy) question that stores the date / time stamp. This question must be an

*ALPHA type question. To store the full return value the length of the *ALPHA field must
be 25 characters. If the length is shorter, the information stored in the question is truncated.

The date is stored in the format "YYYY/MM/DD HHmm:ss +UTC W" (without quotes)
where YYYY is the current year, MM is the current month, DD is the current date, HH is the
current time hour in a 24 hour format, mm is the current time minutes, and ss is the current
time seconds. The value +UTC marks the offset from the UTC (Coordinated Universal
Time) in minutes and is always preceded by a plus or minus sign. Note that the total
number of characters used for the UTC difference is therefore always 4. Last, W is the day
of the week number, where Sunday is 1 and Saturday is 7.

For example, the value "2022/07/15 20:30:18 +060 2" equals to July 15th, 2022
at 20:30 and 18 seconds, 60 minutes (1 hour) later than UTC, and it is a Monday.

<var>

A variable that stores the date / time stamp.
<array>

A numerical array that stores the date / time stamp.

Remarks

e Ifthe variable is a numeric variable (*VARS) only the current year is stored.

e Ifthe variable is a text variable (*TEXTVARS) , the date / time stamp is stored in the same
format as when stored in a question (see above).

e If the variable an array of numeric or text values, the components of the date / time stamp
are split across the array elements, as values. To store all values an array of size 8 is
required — smaller arrays would only store components up until the maximum size:

o Array index 1 returns the year,
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o index 2 -- the month,

o index 3 -day,

o index 4 - the hour,

o index 5 - the minutes,

o index 6 - the seconds,

o index 7 - offset to UTC time zone,

Command Index

o index 8 - day of the week, where 1 is Sunday, 2 is Monday, 3 is Tuesday, 4 is

Wednesday, 5 is Thursday, 6 is Friday, and 7 is Saturday.

e Please note that while Nfield CAPI uses the device’s date and time, the Online surveys always

use the UTC time. The offset will thus always be +000.

Example 1

The following example stores the date / time stamp in an *ALPHA question:
*QUESTION 1 *ALPHA 61L25 *DUMMY

Current date
*DATE QI

Example 2

This example stores the date/time stamp components in an array variable. The month and day of

week names are retrieved from dummy questions to get friendly names. In the time stamp, values

less than 10 get a leading zero to make sure the time is properly displayed. The UTC time stamp is

formatted in hours rather than minutes and gets a leading plus sign if it is positive.

*VARS Date[8], UTC, DayofWeek, Month
*TEXTVARS DayName, MonthName, sign, LeadZeroH,LeadZeroM

*Q1 *CODES L1 *DUMMY
Weekdays

1:Sunday

2:Monday

3:Tuesday

4:Wednesday

5:Thursday

6:Friday

7:Saturday

*Q2 *CODES L2 *DUMMY
Months
1:January
2:February
3:March
4:April
5:May

6:June

7:July
8:August
9:September
10:October
11:November
12:December

*DATE Date

*PUT Month [Date[2]]

*PUT DayOfWeek [Date[8]]
*PUT MonthName Q2,Month
*PUT DayName Q1,DayOfWeek
*PUT UTC [Date[7]/60]

*[F [UTC>=0] *PUT sign "+"
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*IF [Date[4]<10] *PUT LeadZeroH "0"
*IF [Date[5]<10] *PUT LeadZeroM "0"

*PAGE
Start time of this interview:

*?7DayName, *?MonthName *?Date[3] *?Date[1] at *?LeadZeroH*?Date[4]:*?LeadZeroM*?Date[5] (UTC*?sign*?UTC)

6.10.1.1  Please see section below for some date calculation functions:

Date Functions 65
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6.11 *DUMMY

Purpose

Specifies a dummy question.

Syntax

*DUMMY

Description

This command specifies a dummy question. Dummy questions are, for example, closed questions
that will be 